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Contact Us

If you have any comments, suggestions or questions regarding AVS4YOU programs or if you have a new feature that you feel 
can be added to improve our product, please feel free to contact us.

When you register your product, you may be entitled to technical support.

Technical Support

AVS4YOU programs do not require any professional knowledge. If you experience any problem or have a question, please refer 
to the AVS4YOU Programs Help. If you cannot find the solution, please contact our support staff.

Note: only registered users receive technical support. 

AVS4YOU staff provides several forms of automated customer support:

 AVS4YOU Support System
You can use the Support Form on our site to ask your questions.

 E-mail Support
You can also submit your technical questions and problems via e-mail to support@avs4you.com.

Note: for more effective and quick resolving of the difficulties we will need the following information: 

 Name and e-mail address used for registration 

 System parameters (CPU, hard drive space available, etc.) 

 Operating System 

 The information about the capture, video or audio devices, disc drives connected to your computer 

(manufacturer and model) 

 Detailed step by step describing of your action 

Please do NOT attach any other files to your e-mail message unless specifically requested by AVS4YOU.com 
support staff.

General information: info@avs4you.com

Technical support: support@avs4you.com

Sales: sales@avs4you.com

Help and other documentation: help@avs4you.com
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Resources

Documentation for your AVS4YOU software is available in a variety of formats:

In-product (.chm-file) and Online Help

To reduce the size of the downloaded software installation files the in-product help was excluded from the installation although 
you can always download it from our web-site for your convenience. Please, visit AVS4YOU web-site at 
http://onlinehelp.avs4you.com/index.aspx to download the latest available version of the help executable, run it and 
install into the AVS4YOU programs folder. After that you will be able to use it through the Help menu of the installed AVS4YOU 
software.

Online Help include all the content from the In-product help file and updates and links to additional instructional content 
available on the web. You can find the Online Help at our web-site - http://onlinehelp.avs4you.com/index.aspx. Please 
note, that the most complete and up-to-date version of AVS4YOU programs help is always on the web.

PDF Documentation

The offline help is also available as a pdf-file that is optimized for printing. All PDF help files are available for download at the 
programs pages at AVS4YOU web-site (both http://www.avs4you.com/index.aspx and 
http://onlinehelp.avs4you.com/index.aspx). To be able to read and print AVS4YOU PDF help files you will need to have a 
PDF reading program installed.

User Guides

You have access to a wide variety of resources that help you make the most of your AVS4YOU software. The step-by-step user 
guides will be of help not only to the novice users but also to the users that face a certain task to be performed and look for a 
way to do it. Please, visit our User Guides section of AVS4YOU web-site at http://www.avs4you.com/Guides/index.aspx
to read the detailed instructions for various software and tasks

Technical Support

Visit the AVS4YOU Support web-site at http://support.avs4you.com to ask your questions concerning AVS4YOU software 
installation, registration and use. Feel free to also use our e-mail address support@avs4you.com.

Downloads

Visit the Downloads section - http://www.avs4you.com/downloads.aspx - of our web-site to find free updates, tryouts, 
and other useful software. We constantly update the software, new versions of the most popular programs and new software are 
also frequently released.
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Overview

AVS Audio Editor is a feature-rich audio production software that combines advanced audio editing features with an easy-to-use

ribbon-based interface, which makes it suitable for both professionals and amateurs.

Using AVS Audio Editor

you can quickly and easily perform the following tasks:

record audio from any input and import it to the program for further editing;

mix several audio tracks in one;

apply effects and filters to your audio - there are over 20 available including delay, chorus, fade in/out effects, low/high

/bandpass filters etc.;

generate sounds - the software supports generating chirp, noise, DTMF signals;

convert created audio to a wide range of modern audio formats;

customize AVS Audio Editor settings to meet your specific needs.

To start AVS Audio Editor go to Start menu and choose All Programs -> AVS4YOU -> Audio -> AVS Audio Editor.

AVS4YOU Programs Help - AVS Audio Editor

© Online Media Technologies Ltd., UK 2004 - 2011   All rights reserved. www.avs4you.com

Page 4 of  128

http://www.avs4you.com/index.aspx
http://www.avs4you.com/index.aspx


Main Window

AVS Audio Editor main window comprises the following parts:

Application Button gets you to a special menu containing all available operations with files;

Quick Access Toolbar allows you to get quick access to the most frequently used functions of the software;

Ribbon Command Bar is a command bar located at the top of the AVS Auido Editor main window. Comprises the following

tabs: Home, File, Edit, Record, Effects, Generate, DX/VST, Tools, Mix, Favorites, Help;

Files and Effects Panel shows the audio files loaded into the program and gives you quick access to all the available effects

and filters;

Waveform Editing Space provides a visual representation of the audio track you've selected for editing;

Bottom Toolbar is used to playback the selected audio file and navigate through it;

Status Bar is an information area located at the bottom of the AVS Auido Editor main window.
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Application Button

The Application button located in the top left corner of the AVS Audio Editor Main Window is a part of the program

interface that gets you to a special menu containing available operations with files (corresponds more or less to the File

section of the classic menu).

Clicking this button will display a menu with the following elements:

Button/Field Description

New...

Use it to create a new audio file.

Open...

Use it to open an existing audio file. When you load a file for editing, AVS Audio Editor converts the audio file

type to its own internal temporary file type for faster editing and better handling of larger file sizes.

Import from

Video

Use it to import the audio track(s) of a video file into the program.

Grab from CD

Use it to grab an audio CD and add the grabbed tracks to the program.

Save

Use it to save the active audio file with its current file name and location.

Save as...

Use it to save the active audio file with a different file name and/or location, in a different file format.

Save All

Use it to save all the changes to all the opened edited files.

Info/Tags

Use it to view the available audio file information and modify audio tags.

Close
Use it to close the currently opened edited file.

Close All

Use it to close all the opened edited files.

Recent

Files
Use it to display the list of five most recently loaded files.

Preferences

Use it to view and edit the program settings.

Exit

Use it to close AVS Audio Editor.
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Quick Access Toolbar

Quick Access Toolbar located in the top left corner of the AVS Audio Editor Main

Window is a customizable tool allowing you to get quick access to the most frequently used

functions of the software.

Clicking the arrow  to the right of the toolbar will display the Customize Quick Access Toolbar menu (see image below).

Tick/untick the Customize Quick Access Toolbar menu elements

to show/hide them on the toolbar.

Click More Commands... and uncheck the Quick Access Toolbar

box on the Toolbars tab to hide the quick access toolbar.

Tick the Show Quick Access Toolbar below the Ribbon option

to show the toolbar below the ribbon.

Tick Minimize the Ribbon to hide command buttons and button

groups of the Ribbon Command Bar so that only tabs would be

visible. Untick it to make the ribbon command bar fully visible again.

Adding/Removing Elements from Toolbar

You can add/remove elements from Quick Access Toolbar. To add an element to the toolbar, right-click the desired Command

Button on the ribbon command bar and select Add to Quick Access Toolbar:

To remove an element from Quick Access Toolbar right-click it and select Remove from Quick Access Toolbar:
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Ribbon Command Bar

The Ribbon Command Bar located at the top of the AVS Audio Editor Main Window offers a better visibility of the software

functional capabilities which is achieved through sets of intuitive command buttons. Related command buttons are organized in button

groups. Related button groups are organized in tabs.

AVS Audio Editor ribbon command bar comprises the following tabs:

Home Tab

This tab includes buttons that allow you to load audio files into the program, perform some editing operations and get quick

access to most recently used effects and filters.

File Tab

Using the buttons of this tab you can easily create a new file, load some audio files into the program, view their information and

save the edited files into one of the available formats.

Edit Tab

Here you can perform various editing operations: cut, copy, paste, delete some unwanted parts, split your audio by set markers

and add it to your mix project.

Record Tab

On this tab you will be able to record audio from any external device adjusting its balance and gain.

Effects Tab

This tab gets you access to all the available audio effects and the Batch Processing option of AVS Audio Editor.

Generate Tab

Using this tab you can generate a certain sound like silence, noise, signal etc and even convert your text to speech.

DX/VST Tab

This tab allows you to search for the DirectX and VST plug-ins installed on your computer.

Tools Tab

Use this tab to change the data view mode and adjust the AVS Audio Editor program settings.

Mix Tab

This tab includes buttons that allow you to create, edit and save your mix projects.

Favorites Tab

On this tab you can create your own button groups to get access to most frequently used options.

Help Tab

Using this tab you can open AVS Audio Editor help file, read information about the program, register and activate it as well as

download additional file formats packs for proper work with Real Media and Midi formats.
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Home Tab

The Home tab includes the File, Edit, View and Recent Effects button groups. For information on the Home Tab command button

functions please refer to the table below.

Group Command Description

File

New

Use it to create a new audio file.

Open...

Use it to open an existing audio file. When you load a file for editing, AVS Audio Editor converts the

audio file type to its own internal temporary file type for faster editing and better handling of larger file

sizes. Clicking the arrow below this button will additionally display the Open as..., Open and

Append... and Recent Files options.

Open as...

Use it to open an existing audio file as if it were a file of some other format. See the Open as..

section for more detail on it.

Open and

Append...

Use it to open an existing audio file and append it to the end of the previously opened file. The newly

created file will consist of two opened files at once, the second one starting where the first one ends.

Recent Files Use it to display the list of 5 audio files most recently loaded into AVS Audio Editor.

Save

Use it to save the active audio file with its current file name and location. Clicking the arrow below this

button will additionally display the Save as..., Save Selection as... and Save All options.

Save as...

Use it to save the active audio file with a different file name and/or location, in a different file format.

Save Selection

as

Use it to save just the highlighted selection to a file.

Save All

Use it to save all the changes to all the opened edited files.

Import from

Video

Use it to import the audio track(s) of a video file into the program.

Grab from CD

Use it to grab an audio CD and add the grabbed tracks to the program.

Edit

Use it to copy the selection into the program internal clipboard. It is used when you work with one file

within one copy of AVS Audio Editor. Clicking the arrow below this button will additionallly display
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Copy the Copy to New... and Copy to Win Clipboard options.

Copy to New...

Use it to copy the selection or the whole audio file into a new one. A new file will be automatically

created and opened.

Copy to Win

Clipboard

Use it to copy the selection into the windows clipboard so that it would be available to other opened

programs. It is used when you work with two or more copies of AVS Audio Editor and want to

copy/paste from one program to another.

Paste

Use it to insert the contents of the internal clipboard at the insertion point or to replace any selection.

Clicking the arrow below this button will additionally display the Paste from Clipboard... option.

Paste from

Clipboard...

Use it to insert the contents of the windows clipboard at the insertion point or to replace any selection.

Cut

Use it to remove the selection from the active file and place it to the program internal clipboard.

Delete

Use it to remove the current selection. The deleted portion is not copied to the clipboard, and can only

be retrieved through Undo.

Trim to

Selection

Use it to delete everything except the selected portion (the exact opposite of Delete).

Undo

Use it to reverse the last command, such as deletion, transforms, etc. If this option is not available, it

means there is no action to undo. AVS Audio Editor allows virtually unlimited (limited only by hard

drive space) levels of Undo.

Redo

Use it to repeat your latest undone action.

View

Waveform

Use it to choose a Waveform View mode for viewing data. It displays audio data in the familiar

sound wave format, where y-axis (vertical) represents amplitude and x-axis (horizontal) represents

time.

Spectral

Use it to choose a Spectral View mode for viewing data. It displays a waveform by its frequency

components, where x-axis (horizontal) is time, and y-axis (vertical) is frequency. This allows you to

analyze your audio data to see which frequencies are most prevalent.

Envelope

Use it to choose a Envelope View mode for viewing data. It displays audio data in the familiar sound

wave format, where y-axis (vertical) represents amplitude and x-axis (horizontal) represents time. It is

the same as the Waveform View but its boundaries are smoothed.

Recent Effects Use it to get quick access to most recently used audio effects and filters.
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File Tab

The File tab includes the Open, Save/Close, Info File button groups. For information on the File Tab command button functions

please refer to the table below.

Group Command Description

Open

New

Use it to create a new audio file.

Open...

Use it to open an existing audio file. When you load a file for editing, AVS Audio Editor converts

the audio file type to its own internal temporary file type for faster editing and better handling of

larger file sizes. Clicking the arrow below this button will additionally display the Open as...,

Open and Append... and Recent Files options.

Open as...

Use it to open an existing audio file as if it were a file of some other format. See the Open as..

section for more detail on it.

Open and

Append...

Use it to open an existing audio file and append it to the end of the previously opened file. The

newly created file will consist of two opened files at once, the second one starting were the first

one ends.

Recent Files Use it to display the list of 5 audio files most recently loaded into AVS Audio Editor.

Import from

Video

Use it to import the audio track(s) of a video file into the program.

Grab from CD

Use it to grab an audio CD and add the grabbed tracks to the program.

Save/Close

Save

Use it to save the active audio file with its current file name and location.

Save as...

Use it to save the active audio file with a different file name and/or location, in a different file

format.

Save Selection

as

Use it to save just the highlighted selection to a file.

Save All

Use it to save all the changes to all the opened edited files.

AVS4YOU Programs Help - AVS Audio Editor

© Online Media Technologies Ltd., UK 2004 - 2011   All rights reserved. www.avs4you.com

Page 11 of  128

http://www.avs4you.com/index.aspx
http://www.avs4you.com/index.aspx


Close

Use it to close the currently opened edited file. Clicking the arrow below this button will

additionally display the Close All option.

Close All

Use it to close all the opened edited files.

File Info

Info/Tags

Use it to view the available audio file info and modify audio tags.
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Edit Tab

The Edit tab includes the Select, Undo, Editing Options, Process, Markers and Mix button groups. For information on the Edit

Tab command button functions please refer to the table below.

Group Command Description

Select

Select All
Use it to select the whole track.

Select Viewing

Range

Use it to make the selection of the visible area of the audio track only (in case the waveform is

zoomed in, only the area within the visible area will be selected).

Undo

Undo

Use it to reverse the last command, such as deletion, transforms, etc. If this option is not available,

it means there is no action to undo. AVS Audio Editor allows virtually unlimited (limited only by

hard drive space) levels of Undo. Pressing the downward arrow under the Undo button will open

the list of the commands and actions available.

Redo

Use it to repeat your latest undone action. Pressing the downward arrow under the Redo button will

open the list of the commands and actions available.

Editing

Options

Copy

Use it to copy the selection into the program internal clipboard. It is used when you work with one

file within one copy of AVS Audio Editor. Clicking the arrow below this button will additionallly

display the Copy to New... and Copy to Win Clipboard options.

Copy to New...

Use it to copy the selection or the whole audio file into a new one. A new file will be automatically

created and opened.

Copy to Win

Clipboard

Use it to copy the selection into the windows clipboard so that it would be available to other opened

programs. It is used when you work with two or more copies of AVS Audio Editor and want to

copy/paste from one program to another.

Cut

Use it to remove the selection from the active file and place it to the program internal clipboard.

Paste

Use it to insert the contents of the internal clipboard at the insertion point or to replace any

selection. Clicking the arrow below this button will additionally display the Paste from Clipboard...

option.

Paste from

Clipboard...

Use it to insert the contents of the windows clipboard at the insertion point or to replace any

selection.

Paste from

File...

Use it to insert the contents of an audio file at the insertion point or to replace any selection.
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Paste Mix...

Use it to insert the contents of the internal clipboard at the insertion point mixing the audio tracks.

Paste Mix from

File...

Use it to insert the contents of the audio file at the insertion point mixing the audio tracks.

Delete

Use it to remove the current selection. The deleted portion is not copied to the clipboard, and can

only be retrieved through Undo.

Trim to

Selection

Use it to delete everything except the selected portion (the exact opposite of Delete).

Process
Convert

Sample Type

Use it to convert your opened audio to another format or change bitrate, sample rate, number of

channels and so forth.

Markers

Auto Markers

Use it to open the Auto Markers window and start adding the markers automatically.

Add Marker

Use it to add a marker to the currently edited audio.

View Marker

List

Use it to open the Marker List window.

Split File by

Markers

Use it to split currently edited audio file by markers.

Mix

Add File to Mix

Use it to add the currenly edited audio file to mix.

Add Selection

to Mix

Use it to add the currenly selected audio portion to mix.
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Record Tab

The Record tab includes the Input Settings, Recording Controls and Recording Options button groups. For information on the

Record Tab command button functions please refer to the table below.

Group Command Description

Input

Settings

Input Device Use it to select the device you plan to use for recording.

Test Input Use it to test the selected recording device.

Balance Use this sliding bar to adjust the recorded file balance.

Gain Use this sliding bar to adjust the recorded file volume.

Recording

Controls

Record

Use it to start the recording process.

Pause

Use it to pause the recording process.

Stop

Use it to stop the recording process.

Recording

Options
Advanced

Use it to configure the advanced recording options.
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Effects Tab

The Effects tab includes the Amplitude, Delay/Modulation, Time Stretch/Pitch Shift, Filters and Batch button groups. For

information on the Effects Tab command button functions please refer to the table below.

Group Command Description

Amplitude

Amplify
Click it to apply the Amplify effect to your audio.

Fade In/Out

Click it to apply Fade In or Fade Out effect to audio.

Normalize

Click it to apply the Normalize effect to your audio.

Envelope

Click it to apply the Envelope filter to your audio.

Compressor

Click it to apply the Compressor effect to your audio.

Multiband

Compressor

Click it to apply the Multiband Compressor effect to your audio.

Mute

Click it to mute the selected audio portion.

Invert

Click it to apply the Invert effect to your audio.

Limiter

Click it to apply the Limiter filter to your audio.

Auto

Correction

Click it to apply the Auto Correction to your audio.

Delay/Modulation

Echo

Click it to apply the Echo effect to your audio.

Chorus

Click it to apply the Chorus effect to your audio.
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Flanger

Click it to apply the Flanger effect to your audio.

Phaser

Click it to apply the Phaser effect to your audio.

Reverb

Click it to apply the Reverb effect to your audio.

Vibrato

Click it to apply the Vibrato effect to your audio.

Voice Morpher

Click it to apply the Voice Morpher effect to your audio.

Time

Stretch/Pitch

Shift

Tempo

Change

Click it to apply the Tempo Change effect to your audio.

Pitch Shift

Click it to apply the Pitch Shift effect to your audio.

Rate Change

Click it to apply the Rate Change effect to your audio.

Reverse

Click it to apply the Reverse effect to your audio.

Filters

Equalizer

Click it to apply the Equalizer filter to your audio.

Parametric

Filters

Click it to apply the Parametric filters to your audio.

FFT Filter

Click it to apply the FFT filter to your audio.

Delete Silence

Click it to apply the Delete Silence filter to your audio.

Noise Gate

Click it to apply the Noise Gate filter to your audio.

Noise Removal

Click it to apply the Noise Removal filter to your audio.
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Batch

Batch

Click it to open the Batch Processing window.

Generate Tab

The Generate tab includes the Simple, DTMF and Speech button groups. For information on the Generate Tab command button

functions please refer to the table below.

Group Command Description

Simple

Silence

Use it to create a period of silence of a certain length within the audio.

Noise

Use it to create a noise signal of a certain type and length within the audio.

Signal

Use it to create a signal with certain parameters within the audio.

Chirp

Use it to create a chirp signal with certain parameters within the audio.

DTMF

DTMF Signals

Use it to create DTMF signals with certain parameters within the audio.

Speech

Text to Speech

Use it to convert the written text into speech.
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DX/VST Tab

The DX/VST tab includes the only Effect Processing button group. For information on the DX/VST Tab command button functions

please refer to the table below.

Group Command Description

Effect

Processing

VST

Directories

Use it to add or remove the VST effects loaded to AVS Audio Editor and available for audio

editing.

Refresh VST

Effects

Use it to refresh the list of VST effects in case some effects became available.

VST Effects

Use it to list VST effects installed on your system and apply them to the audio.

Refresh DX

List

Use it to refresh the list of DirectX filters in case some effects became available.

DX Effects

Use it to list DirectX filters installed on your system and apply them to the audio.
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Tools Tab

The Tools tab includes the Analysis, Settings, Scales and Bars and View button groups. For information on the Tools Tab

command button functions please refer to the table below.

Group Command Description

Analysis

Frequency

Analysis

Use it to show or hide Frequency Analysis Window. The Frequency Analysis Window

contains a graph of the frequencies at the insertion point or at the center of a selection.

Phase Analysis

Use it to show or hide Phase Analysis Window.

Settings

Options...

Use it to view and edit the program settings.

Scales

and

Bars

Time Scale

Format

Use it to change the format of the horizontal scale which represents the timeline of the audio file.

The possible values include: Decimal (mm:ss.ddd), Samples, Frames 60 fps, Frames 59,94

fps, Frames 50 fps, Frames 30 fps, Frames 29.97 fps, Frames 25 fps and Frames 24 fps.

Vertical Scale

Format

Use it to change the format of the vertical scale which represents the changes of the audio in the file

within time. The possible values include: Sample Values, Percentage and Decibels.

Status Bar

Use it to show or hide the elements of the Status Bar. The possible items include: Sample

Format, File Size and Duration (mm:ss.ddd).

View

Waveform

Use it to choose a Waveform View mode for viewing data. It displays audio data in the familiar

sound wave format, where y-axis (vertical) represents amplitude and x-axis (horizontal) represents

time.

Spectral

Use it to choose a Spectral View mode for viewing data. It displays a waveform by its frequency

components, where x-axis (horizontal) is time, and y-axis (vertical) is frequency. This allows you to

analyze your audio data to see which frequencies are most prevalent.

Envelope

Use it to choose a Envelope View mode for viewing data. It displays audio data in the familiar

sound wave format, where y-axis (vertical) represents amplitude and x-axis (horizontal) represents

time. It is the same as the Waveform View but its boundaries are smoothed.
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Mix Tab

The Mix tab includes the Mix Project, Lines/Objects, Mix Undo/Redo, Mix Volume and Mix Effects button groups. For

information on the Mix Tab command button functions please refer to the table below.

Group Command Description

Mix Project

New Project

Use it to create a new audio project.

Open

Project...

Use it to open an existing mix project. Clicking the arrow below this button will additionally

display the Recent Projects option.

Recent

Projects
Use it to view a list of the projects that have been recently loaded into AVS Audio Editor..

Save Project

Use it to save the currently edited mix project with its current file name and location.

Save Project

as...

Use it to save the currently edited mix project with a different name and/or location. The

project will be saved as a project file with the .mix extension.

Export Audio

Use it to export audio from the mix project and save it to one of the available audio formats.

Lines/Objects

Open Audio

File

Use it to load n audio track into the mix working space. The selected file will be placed to the

empty line at current curor position.

New Line

Use it to add a new line to the mix working space.

Duplicate Line

Use it to duplicate the selected line in the mix working space.

Clear Line

Use it to clear the selected line in the mix working space.

Duplicate

Object

Use it to duplicate the currently selected object in the mix working space. The object wil be

duplicated in the same line.
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Delete Object

Use it to delete the currently selected object in the mix working space.

Edit Object

Use it to edit the currently selected object in the mix working space.

Split Object

Use it to split the currently selected object in the mix working space at current cursor position.

Object

Properties

Use it to view the currently selected object properties.

Mix

Undo/Redo

Undo
Use it to cancel the last acion performed in the mix working space.

Redo
Use it to repeat the last undone action performed in the mix working space.

Mix Volume

Balance Use it to set the stereo balance of your audio mix.

Gain Use it to set the volume of your audio mix.

Mix Effects

Amplify

Left-click it to apply the Amplify effect to your audio.

Fade In/Out

Left-click it to apply Fade in or Fade out effect to audio.

Envelope

Left-click it to apply the Envelope effect to your audio.

Compressor

Left-click it to apply the Compressor effect to your audio.

Multiband

Compressor

Left-click it to apply the Multiband Compressor effect to your audio.

FFT Filter

Left-click it to apply the FFT Filter to your audio.

Chorus

Left-click it to apply the Chorus effect to your audio.

Echo

Left-click it to apply Echo effect to audio.
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Flanger

Left-click it to apply the Flanger effect to your audio.

Phaser

Left-click it to apply the Phaser effect to your audio.

Reverb

Left-click it to apply the Reverb effect to your audio.

Vibrato

Left-click it to apply the Vibrato effect to your audio.

Pitch Shift

Left-click it to apply Pitch Shift effect to audio.

Equalizer

Left-click it to apply the Equalizer filter to your audio.

Noise Gate

Left-click it to apply the Noise Gate filter to your audio.

Parametric

Filters

Left-click it to apply Parametric Filters to your audio.

Limiter

Left-click it to apply Limiter filter to your audio.
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Favorites Tab

The Ribbon Command Bar located at the top of the AVS Audio Editor main window contains tabs with a set number of commands

which are already grouped in a certain way. The Favorites tab has been designed specifically for you to display the most frequently

used commands in a single place and group them according to your wish.

The Favorites tab is empty by default. To customize it (create Button Groups and add Command Buttons), do the following:

Right-click the Favorites tab and select More Commands... to open the Customize window.

On the Toolbars tab, click New... to create a new button group. Enter a name for your new button group and press OK. The

new empty button group will appear on the Favorites tab:

To add command buttons to your button group (toolbar), switch to the Commands tab. Select the desired command button,

then drag and drop it within the button group you have just created.
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Use the Options tab of the Customize window to set Ribbon Command Bar properties.

Tick the Large icons option to show large icons on the ribbon command bar.

Tick Show tooltips on toolbars to display tooltips (hints) when you place the cursor over ribbon command bar elements.

Tick Show shortcut keys in tooltips to include shortcuts in tooltips (hints).
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Help Tab

The Help tab includes Help, Registration and Additional Packs Links groups. For information on the Help Tab command button

functions please refer to the table below.

Group Command Description

General

Help

Use it to open the Help File window.

About

Use it to open the window that shows the information about AVS Audio Editor.

Our Site

Use it to see the links to AVS4YOU.com on the web.

Registration

Register

Goes to the AVS4YOU registration page where you'll be able to purchase the software.

Activate

Opens the Activation window where you will be able to enter a license key and activate your

copy of AVS Audio Editor.

Additional

Packs Links

Real Media

Pack

Goes to our server to download the additional components to work with Real Media file

formats.

Midi Pack
Goes to our server to download the additional components to work with Midi file formats.
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Files and Effects Panel

Files and Effects Panel is a universal easy-to-use tool to perform many different operations with audio files. Using this panel you can

add, remove files and apply various effects and filters to the opened files.

If you select the Files tab of the panel, you will be able to see the list of the files currently loaded into AVS Audio Editor:

All the newly created files will have the Unknown name until you save them and assign a name to them. You can add new files to the

list, remove the unwanted ones from the list or create new files using the corresponding elements of the right-click menu.

To start applying effects to the files loaded into AVS Audio Editor switch to the Effects tab:

The Effects tab menu consists of the following submenus:

Amplitude Effects

Delay/Modulation Effects

Time Stretch/Pitch Shift

Filters

Generate

DX Effects

VST Effects

The Favorites tab lists the most frequently used effects and filters:

You can use the effects and filters from this list to quickly access and reuse them.
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Waveform Editing Space

Waveform Editing Space consists of five main parts:

Waveform Display

Display Range Bar

Time Scale

Vertical Scale

Volume Indicators

Waveform Display

Waveform Display is the area where you view your audio material. There are many mouse operations available in the Waveform

Display to select data:

Left-click anywhere in the waveform and you will change the position of the playback cursor.

With stereo or multichannel waveforms, use the Control key of the keyboard together with the mouse pointer (the cursor will

acquire L or R letter - Lf, Rf, Cf, LFE, Lr, Rr, Ls and Rs for eight channel audio) and left-click to enable only the necessary

channel for editing (the disabled channels will gray-out), another left-click within the disabled channel will re-enable it.

Left-click and drag in the waveform display to make a selection.

Double left-click in the waveform display to select the entire visible portion of the waveform (when zoomed in this does not

select unseen areas which may be to the right or left).

Display Range Bar

The Display Range Bar on the top of the Waveform Display window indicates which part of the entire waveform is currently being

viewed in the Waveform Display. When zooming in or out, this bar will get smaller or larger, as the portion being viewed changes

with respect to the entire waveform or session.

Left-click (the mouse cursor should change to a hand) and drag the bar to scroll forward or backward in time:
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Display Range Bar with mouse cursor over it

Display Range Bar with mouse cursor down. Now you can drag the bar to scroll forward or backward in time

As with dragging in the Time Scale, the zoom level is retained, only the viewing range is altered.

To change the zoom level, move the mouse cursor to the edge of the Display Range Bar in zoom-in mode (it will turn to the

double-sided arrow with a magnifying glass) and drag it to zoom out or zoom in:

Display Range Bar zoomed with mouse cursor

Time Scale

Time Scale shows the current location at any point in the waveform display. The time markings are subdivided into more detail when

zoomed in, and less detail when zoomed out.

Left-click (the mouse cursor should change to a hand) and drag the ruler to scroll forward or backward in time:

Time Scale with mouse cursor over it

Time Scale with mouse cursor down. Now you can drag the ruler to scroll forward or backward in time

As with dragging in the Display Range Bar, the zoom level is retained, only the viewing range is altered.

You can select the measurment units for the Time Scale using the Scales and Bars button group of the Tools Tab - press the Time

Scale Format button and select one of the following values: Decimal (mm:ss.ddd), Samples, Frames 60 fps, Frames 59,94 fps,

Frames 50 fps, Frames 30 fps, Frames 29.97 fps, Frames 25 fps and Frames 24 fps (you can select the measurement units for

the Time Scale using the right-click mouse menu on it).

Vertical Scale

Vertical Scale measures the changes of audio data at a certain moment of time. You can select the

measurement units for the Vertical Scale using the Scales and Bars button group of the Tools Tab - press

the Vertical Scale Format button and select one of the following values: Sample Values, Percentage and

Decibels (you can select the measurement units for the Vertical Scale using the right-click mouse menu on

it).

Volume Indicators

Volume Indicators will show the current signal level. They are used to control the sound volume during

recording. While recording, the bars will change their height continuously. No bars or no bar change mean that

there is no signal coming from your input device.
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Mix Timeline

The Mix Timeline tool is displayed when you switch to the Mix Tab of the AVS Audio Editor Ribbon Command Bar. It consists of the

following parts:

Time Scale

Audio Mix/Audio Recording Lines

Audio Effect Lines

Time Scale

The Time Scale located on the top of the Mix Timeline area shows the current location at any point in the mix working space. The

time markings are subdivided into more detail when zoomed in, and less detail when zoomed out.

To zoom in/out use the buttons on the left of the Time Scale.

Button Name Description

Zoom in Use this button to zoom in the Time Scale to find a certain scene

Zoom out Use this button to zoom out the Time Scale till the needed size

Zoom to fit Use this button to recover the 100% view
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Right-clicking within this scale will activate the Time Scale Express Menu. This menu allows you to access to the available operations

with markers.

Button Description

Add Marker Use it to add marker at the current cursor position.

Auto Add Markers
Use it to set markers at the beginning of each audio file added to this

audio mix line.

Previous Use it to go to the previous marker on the Time Scale.

Next Use it to go to the next marker on the Time Scale.

Delete Marker Use it to delete the currently selected marker.

Clear All Markers Use it to delete all the set markers.

Audio Mix/Audio Recording Lines

The Mix Timeline is divided in lines dipending on the file number you add for mixing. Each line includes the working space where the

audio waveform is displayed and the Toolbar which consists of the following items:

Element Description

Delete
Use it to delete the selected audio file from the mix and clear the audio mix line.

Balance Use this sliding bar to adjust the selected audio file balance.

Gain Use this sliding bar to adjust the selected audio file volume.

Mute
Use it to mute the selected audio mix line.

Solo
Use it to mute all the lines except the selected one.

Recording
Use it to start the recording process.

Right-clicking within the Audio Mix line will activate the Express Menu which will help you access the main line editing options.

If the Audio Mix Line is empty the options displayed in the activated right-click menu

correspond to the buttons of the Lines/Objects group on the Mix Tab.
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If there is some audio file added to your mix you will be presented with the following Audio

Mix Line Express Menu:

Button Description

Loop the Selection

Playback
Use it to repeatedly play the selected part of the audio file.

Duplicate Object

Use it to duplicate the currently selected object in the mix

working space. The audio file wil be duplicated and displayed

in the same line.

Delete Object
Use it to delete the currently selected object in the mix

working space.

Edit Object

Use it to open the file in the Edit mode. The file will be added

to the Waveform Editing Space, and you'll be able to apply all

available editing options, as well as effects and filters in order

to edit this file.

Split Object
Use it to split the currently selected object in the mix working

space at current cursor position.

Object Properties Use it to view the currently selected audio file properties.

Reset Envelope Use it to reset the envelope of currenlty selected audio file.

Audio Effect Lines

AVS Audio Editor allows you to apply one or several effects to your mix. Each effect you add will be displayed in the separate Audio

Effect line. The Toolbar on the left of each line includes the following buttons:

Element Description

Delete
Use it to delete the currently selected effect.

Mute
Use it to mute the currently selected effect line.

Solo
Use it to mute all the lines except the selected one.

Right-clicking within this line will activate the Express Menu which facilitates the access to the main effect line editing options.

If the Audio Effect Line is empty the options displayed in the activated right-click menu correspond to

the buttons of the Lines/Objects group on the Mix Tab.
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Clicking with the right mouse button within the added audio effect block will display the following

Express Menu:

Button Description

Edit Effect
Use it to open the selected Audio Effect properties window and adjust

them

Duplicate Object
Use it to duplicate the currently selected effect in the mix working space.

The object wil be duplicated and displayed in the same line.

Delete Object Use it to delete the currently selected effect in the mix working space.

Split Object
Use it to split the currently selected effect in the mix working space at

current cursor position.
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Bottom Toolbar

Bottom Toolbar consists of the following main parts:

Audio player

Zooming toolbar

Current position field

Time display

Audio Player consists of the following buttons:

In the table below you will find the functions you can perform with the help of each button:

Button Name Description

Play

Starts playback of the current selection, or of the current audio file from either the left edge of the

selection, or from the beginning of the file, to either the right edge of the selection or to the end of

the file.

Play Looped Plays the current audio file or selection repeatedly, looping it until the Stop button is pressed.

Play to End
Starts playback of the current selection, or of the current audio file from either the left edge of the

selection, or from the beginning of the file, to the end of the file.

Rewind Rewinds the audio back several thousandths of a second.

Forward Steps the audio forward several thousandths of a second.

Record Start the recording from the source selected in the AVS Audio Editor Parameters dialog.

Pause Pauses playback.

Stop Stops playback.

Go to Previous

Marker

Quickly goes to the previous set marker. If there are no markers set in the audio, then this option lets

the user quickly go to the beginning of the audio.

Go to Next

Marker

Quickly goes to the next set marker. If there are no markers set in the audio, then this option lets the

user quickly go to the end of the audio.

Zooming toolbar consists of the following buttons:

In the table below you will find the functions you can perform with the help of each button:

Button Name Description

Zoom In
Zooms in on the center of the current audio file window. After zooming, use the Time Scale to scroll

to the desired location.

Zoom Out Zooms out from the current location.
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Full Zoom Zooms all the way out to fit the entire waveform or session in the display window.

Vertical Zoom

in
Increases the vertical resolution scale of the waveform and Vertical Scale.

Zoom in to Left

Edge of

Selection

Zooms in to the left edge of the current selection.

Zoom to

Selection
Zooms to the current selection. If no selection is made, this button zooms in on the cursor location.

Zoom in to

Right Edge of

Selection

Zooms in to the right edge of the current selection.

Vertical Zoom

Out
Decreases the vertical resolution scale of the waveform and Vertical Scale.

Current Position Field displays the current position of the active window cursor (measured in

hours:minutes:seconds:thousandths of seconds by default):

When you change the units of the Time Scale to the samples or frames, the units of the Current Position Field will be changed as

well.

Time Display consists of 6 fields:

These fields display start, end, and length information for the visible portion of the current waveform or session, as well as for the

currently selected range. The top row of fields shows the selection time, and the bottom row the viewing range.

Status Bar

Status Bar displays information relating to the file properties and the uncompressed file size.

In the left part of the bar you can see the current file operation status, then the information on the format of the current waveform or

session, with sample rate, sample size and the number of channels. In the middle part of the Status Bar the file size is displayed. In

the right part of the bar you can see the duration of the audio (in hours:minutes:seconds.thousands of seconds). When you

change the units of the Time Scale to the samples or frames, the units of the duration will be changed as well.

Note: you can select to show or hide the file information in the Status Bar using the Status Bar button of the

Tools Tab.
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Frequency Analysis Window

Frequency Analysis Window contains a graph of the frequencies at the insertion point (yellow arrow cursor) or at the center of a

selection. This window "floats", meaning that you can click in the waveform on the main AVS Audio Editor window to update the

analysis while the Frequency Analysis window is on top.

The information in this dialog is like one "slice" or line in the Spectral View of the waveform. The most prominent frequency is

interpolated and displayed. You can move the mouse over the graph area to display the frequency and amplitude components of that

frequency.

The Frequency Analysis window is updated in real time while you play your file.

You can select the properties of the Frequency Analysis using the appropriate options:

FFT Size - the size of the FFT filter. You can select between the following values: 64, 256, 1024, 4096 and 16384.

Window - the amount of transition width and ripple cancellation that occurs during filtering, with each one resulting in a

different frequency response curve. You can select between None, Welch, Bartlett, Hanning and Hamming.

View Type - the appearance of the graph. You can select between Analog, Normal, Fire, Glass and Kryptonite depending

on your needs and preferences.

Visible Channels - the number of channels of the audio used to produce the Frequency Analysis. You can either select all

the channels or switch off some of them. One of the channels have always to stay on.

To display the Frequency Analysis window, switch to the Tools Tab and press the Frecuency Analysis button.
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Phase Analysis Window

Phase Analysis Window is used to reveal phase differences between the stereo channels of an audio file. This window "floats",

meaning that you can click in the waveform on the main AVS Audio Editor window to update the analysis while the Phase Analysis

window is on top.

Phase analysis may be of help if you plan to convert a stereo file to a single-channel audio. When you convert stereo to mono, the

sounds in both channels are summed up. If sounds in both channels are in-phase it will cause no problems. If the channels in the

original audio are out-of-phase, the resulting mono file may have significant sound distortions.

To check whether the channels of the audio file you plan to convert to mono are in-phase, start the file playback, then open the Phase

Analysis window by pressing the corresponding button on the Tools Tab. Follow the pink image changes in the window. If it's more

vertically stretched (like on the figure above), it means that the left and right channels of your stereo file are in-phase and it can be

easily converted to mono. If the image is stretched horisontally, you can correct it by means of inverting one of the channels of the

original audio. After this operation is done you can convert your file to mono.

The Phase Analysis window is updated in real time while you play your file.

You can select the properties of the Phase Analysis using the appropriate options:

FFT Size - the size of the FFT filter. You can select between the following values: 64, 256, 1024, 4096 and 16384. The bigger

the value is, the more precise the analysis will be, but overall analysis speed will decrease.

Visible Channels - the number of channels of the audio used to produce the Phase Analysis. Both should be activated for

stereo signal phase comparison.
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Keyboard and Mouse Shortcuts

To speed up your editing AVS Audio Editor offers you a wide variety of keyboard shortcuts. Use the table below to learn how to edit

audio data in a fast and easy way.

Keyboard

Controls Shortcut Key Description

File Controls

Ctrl+N Creates a new, initially blank file.

Ctrl+O Opens an existing audio file.

Ctrl+S Saves the selected audio file to the hard disk drive.

Shift+Ctrl+S
Saves the active audio file with a different file name and/or location, in a different file

format.

Ctrl+P Opens the File Info window.

Ctrl+Tab Navigates through the audio files loaded into the program.

Ctrl+W Closes the selected audio file.

Editing

Controls

Ctrl+A Selects Entire Waveform.

Ctrl+Z Undo, reverses the last command or action.

Shift+Ctrl+Z Redo, repeats the last command or action.

Ctrl+X Cuts a waveform to internal clipboard.

Ctrl+C Copies a selection to internal clipboard.

Ctrl+V Pastes from internal clipboard.

Ctrl+T Trims to selection.

Del Deletes selection.

Navigation

Controls

Left Arrow Move cursor left on the Timeline.

Right Arrow Move cursor right on the Timeline.

Home Move cursor to the beginning of the waveform on the Timeline.

End Move cursor to the end of the waveform on the Timeline.

Space Starts/stops playing the selected audio file.

Selection

Controls

Shift+Left

Arrow
Increase the left selection boundary.

Shift+Right

Arrow
Increase the right selection boundary.

Ctrl+Left

Arrow
Decrease the left selection boundary.

Ctrl+Right

Arrow
Decrease the right selection boundary.
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Shift+Home Move the left selection boundary to the beginning of the waveform.

Shift+End Move the right selection boundary to the end of the waveform.

Zoom Controls

Ctrl+Numeric

Pad Plus
Zooms In

Ctrl+Numeric

Pad Minus
Zooms Out

Miscellaneous

F1 Brings up the current Help File

F12 Opens the About window

Mouse Operations

Left click and drag a waveform to make a selection.

Double left-click a waveform to select the entire visible portion of the waveform (when zoomed in this does not select unseen areas

which may be to the right or left).

Left-click anywhere in the waveform and you will change the position of the playback cursor.

For stereo or multichannel waveforms:

use the Control key of the keyboard together with the mouse pointer (the cursor will acquire L or R letter - Lf, Rf, Cf, LFE, Lr

and Rr for six channel audio) and left-click to enable only the necessary channel for editing (the disabled channels will gray-out),

another left-click within the disabled channel will re-enable it;

use the Shift key of the keyboard and left-click within the channel delimiter to resize the channel fields, a double click within the

channel delimiter will restore the original channel field size;

Left-click (the mouse cursor should change to a hand) and drag the Display Range Bar to scroll forward or backward in time.

Click and drag on the Time Scale to scroll horizontally.

Rest mouse over any toolbar button to get an explanation of the button's function.

Double-click title bar to Maximize/Restore.

Wheel Mouse Specific

Roll the mouse wheel forward to zoom in. Roll the mouse wheel backwards to zoom out.
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Working with AVS Audio Editor

Working with AVS Audio Editor is quite simple and does not require any specific knowledge on audio editing. All you need is to follow

simple steps that will help you edit your audio.

Add audio files to the program

Load the audio file(s) you wish to edit using one of the available options: open files stored on your PC, grab audio from CDs,

import audio track(s) of a video file, record audio from any external sources or create a new file.

Note: to check the list of audio files supported by AVS Audio Editor refer to the Supported Formats

chapter.

Perform basic editing operations

All the loaded audio files will be displayed within the Files and Effects Panel. Double-click the file you wish to edit and switch to

the Edit Tab. Here you will be able to cut out some unnecessary fragments, copy the selected part of the audio and paste it to

some other place of the same audio or to a different audio.

Apply effects and filters

To enhance the sound quality or create a particular effect switch to the Effects Tab. The detailed description of each effect can

be found in the Applying Effects and Filters chapter.

Generate sounds

Switch to the Generate Tab if you wish to add some signals to your audio like silence, noise, chirp etc. For more information

refer to the Generating Sounds chapter.

Mix audio tracks

If you wish to mix several audio files and apply some effects and filters to your mixes open the Mix Tab and follow the

instructions of the Mixing Audio Tracks chapter.

Save audio files

Save the edited audio files to any supported audio formats using one of the methodes described on the Saving Files page.
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Supported Audio Formats

Most of the commonly used media file formats are supported by AVS Audio Editor:

Format Read Write

MP3 - MPEG-1 Layer 3 Audio

(.mp3)
+ +

WMA - Windows Media Audio Format

(.wma)
+ +

WAV, or WAVE - Waveform Audio Format

(.wav)
+ +

M4A - MPEG-4 Compressed Audio Format

(.m4a)
+ +

M4R - iPhone ringtones

(.m4r)
+ +

AAC - Advanced Audio Coding

(.aac)
+ +

AMR - Adaptive Multi-Rate Narrowband/Wideband

(.amr, .awb)
+ +

OGG - Ogg Vorbis Audio Format

(.ogg)
+ +

MP2 - Musicam, or MPEG-2 Level ll

(.mp2)
+ +

FLAC - Free Lossless Audio Codec

(.flac)
+ +

AIFF - Audio Interchange File Format

(.aiff)
+ -

AU - Au File Format

(.au)
+ -

Musepack File Format

(.mpc)
+ -

Matroska Audio Files

(.mka)
+ -

RAW Files

(.raw, .pcm, .gsm)
+ -

Midi Files 1

(.mid, .midi, .kar)
+ -

APE Files

(.ape)
+ -

QCP Files

(.qcp)
+ -
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MPA Files

(.mpa)
+ -

Real Audio Files 1

(.ra)
+ -

Shorten Files

(.shn)
+ -

Creative Voice Files

(.voc)
+ -

1 - if the appropriate pack is installed on your computer.

Supported Video Formats

Most of the commonly used video file formats are supported by AVS Audio Editor:

Format Read* Write**

AVI Files - Audio Video Interleave

(.avi, .ivf, .div, .divx, .mtv, .amv)
+

+

(except .mtv and .amv)

MPEG Video - Motion Picture Experts Group

(.mpg, .mpeg, .mod, .mpe, .mvv, .m2v)
+

+

(except .m2v)

Windows Media Formats

(.wmv, .asf)
+ -

Microsoft Digital Video Recorder

(.dvr-ms)
+ -

CD Video

(.dat)
+ -

DVD Video

(.ifo)
+ -

VOB Video

(.vob, .vro)
+ -

Blu-ray Video

(index.bdm, index.bdmv, .m2ts)
+ -

AVCHD, HDV

(.m2ts, .m2t, .mts, .tod)
+

+

(.mts and .tod only)

TS Files

(.ts, .m2ts, .m2t, .mts, .tp)
+ -

DV Files

(.dv)
+ -

Matroska Files

(.mkv)
+ -

Ogg Vorbis Movie

(.ogm, .ogg, .ogv, .oga, .ogx)
+ -
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Real Media

(.rm, .rmvb, .ram, .ivr)
+ -

Quick Time

(.mov, .qt, .m4v, .mp4)
+ +

Mobile Video

(.3gp2, .3gpp, .3gp, .3g2)
+ +

Flash Video

(.flv)
+ +

Shockwave Flash

(.swf)
+ -

* Supporting a video file for reading means that you can import its audio track into AVS Audio Editor, edit and then save it as an

audio file of one of the supported formats.

** Supporting a video file for writing means that you can open it in AVS Audio Editor as a video file, edit and then save it as a video

file with the edited audio track.
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Operations with Files

When you use AVS Audio Editor you will need to select some files, load them into the program, view their information and save them

into different formats.

Using the items of the File Tab you can quite easily:

create a new file;

open an existing file for editing;

view the file information;

save the edited file into one of the available formats.

Creating a New File

Press the New...  command button on the Home Tab or File Tab (the same New File option can be accessed from the

Application Button menu or Quick Access Toolbar). The following window will be opened:

Select the Sample Rate (8'000 - 96'000 Herz), Sample Size (8-bit - 32-bit) and the Number of Channels (1/0 - mono -- 3/4+LFE

7.1 surround). Specify the new file name and check the Auto-add date_time to file name option if necessary. Then click the OK

button to quickly create a file of the selected format.

Note: AVS Audio Editor creates all files using a temporary audio file format and saves all the changes to the edited

file only when you select to Save them using one of the ways.
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Opening Files

Opening Audio Files

To start editing a file, you need to load it into AVS Audio Editor. There are several ways to do it:

The easiest way to add a file to the program is to right-click it with the mouse and choose the AVS Edit Audio option from the

context menu.

This way you can both open the audio and import video to edit its audio track.

1.
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Select the Open...  command button on the Home Tab or File Tab. The following window will be opened:

You can select a file or several files with your mouse or keyboard and click the Open button.

2.

Select the Open as...  command button on the Home Tab or File Tab (the Open as... option will be displayed after you

press the arrow next to the Open button). This option will let you open the file as if it were of a different format than it actually

is (so called "quick-and-easy" conversion method). After you select a file or several files in the window above, you will be offered

to set the following parameters:

Select the Sample Rate (8'000 - 96'000 Herz), Sample Size (8-bit - 32-bit) and the number of Channels (1/0 - mono --

3/4+LFE 7.1 surround) and click the OK button to quickly convert the edited file into the selected format.

Note: the original file will not be converted unless you decide to save it. AVS Audio Editor opens all files

into a temporary format and saves all the changes to the original file only when you select to Save them

using one of the ways.

3.
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Select the Open and Append...  command button on the Home Tab or File Tab (the Open and Append... option will

be displayed after you press the arrow next to the Open button). This option will let you open the file and append it to the

already opened one making one file out of two. The files will be merged into one with the second opened file appended to the

end of the first opened one.

4.

AVS Audio Editor supports all popular audio formats. Refer to the Supported Audio Formats chapter to see the list of the supported

formats. When you load a file for editing, AVS Audio Editor converts the waveform type to its own internal temporary file type for

faster editing and better handling of larger file sizes.

Opening Video Files

You can import a video file into AVS Audio Editor with the purpose of editing its audio track(s). You can open video files of the

following formats:

AVI Files (.avi, .ivf, .div, .divx)

Mpeg Files (.mpg, .mpeg, .mod, .mpe, .mvv)

Quick Time Files (.mov, .qt, .m4v, .mp4)

Mobile Video (.3gp2, .3gpp, .3g2, .3gp)

AVCHD (.mts, .tod)

Flash Video (.flv)

To open a video file, select the Open...  command button on the Home Tab or File Tab. Browse for the necessary video file

(make sure the All Video Files option is selected in the opened window) and press Open. The selected video file will be added to the

Files section of the Files and Effects Panel:

In case the video file you are importing contains several audio tracks, you will be presented with the following window:
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Select the necessary audio track and press OK. The video file with the selected audio track will be imported into the program.

You can edit the audio track of your video file just like any audio track loaded into the program. Just note that you can apply a limited

number of effects to your audio tracks. AVS Audio Editor will not allow you to apply effects that change the track duration and

generate sounds.

When saving your video file, you will be able change its audio track format. The result will be saved as a video file with the edited

audio track of the selected audio format.
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Grabbing Audio CDs

AVS Audio Editor allows you to grab audio CDs and import the grabbed audio into the program for editing. To load audio files from a

CD into AVS Audio Editor press the Grab from CD button on the Home Tab or File Tab. You will be presented with the following

window:

Select the CD Drive with the disc which contains the tracks you wish to load into the program. As soon as you do so, all the tracks on

the disc will be displayed in the area below.

Uncheck the boxes for the tracks you are not planning to import into AVS Audio Editor. Use the Check/Uncheck all tracks option

to quickly select or deselect all tracks in the list.

Specify the Grabbing Method in the appropriate window. The following options are available:

Burst Mode - use it for fast grabbing without error correction. Select it for grabbing discs in perfect condition (with no

scratches or other visible damage).

Sync Mode - use it for fast audio track grabbing. Only jitter errors will be corrected if present.

Secure Mode - use it for good-quality grabbing. Errors will be corrected with double precision but overall grabbing speed will

descrease.

Paranoid Mode - the slowest and the most accurate grabbing mode available.

Rename your audio tracks. You can get the information from the online database for your audio CD. To do that click the Options

button, switch to the CDDB Options tab and specify the source of CDDB information from the list. If necessary you can replace, add or

delete servers using the Replace, Add or Delete buttons accordingly. You can also switch to the Proxy Options tab and specify the

Proxy, User Name, Port and TimeOut details if you would like to.

After choosing the server press the OK button to close the File Name Options. Then click the Get CDDB button in the bottom right

corner of the window. If there is some information you will see the album title displayed in the CDDB Albums field. The audio tracks

will be renamed according to the data obtained from the CDDB server.

Select the details to include in the file name. Click the Options button and switch to the File Name tab. Here you will be able to select

the details you want to include checking the box near the corresponding item and set their sequence using the arrow buttons.

Click OK to start the grabbing process. Press Cancel any time during the grabbing process to cancel it.

As soon as the grabbing is finished, all selected tracks will appear on the Files tab of the Files and Effects Panel.
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Importing Audio Tracks from Video

AVS Audio Editor allows you to load audio track(s) of a video file, edit and save it(them) to one of the available audio formats. To

import the audio track of a video file, press the Import from Video button on the Home Tab or File Tab. The following window will

be opened:

Browse for the video file you wish to import and press Open. The audio track of the selected video file will be added to the Files

section of the Files and Effects Panel:

If you wish to import the audio track of a DVD Video, please select the video_ts.ifo file when opening your DVD:
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In case the video file or DVD movie you are importing contains several audio tracks, you will be presented with the following window:

Select the necessary audio track and press OK. The selected audio track will be imported into the program.
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Viewing File Info/Editing Audio Tags

When you first open a file it might be quite useful to know as much information about it as possible. This can be done pressing the

Info/Tags  button on the File Tab:

The File Info tab of the opened window contains the following information:

The File section contains information about File Name, File Size and its Duration.

The Audio section contains information about audio track properties including Sample Rate, Sample Size, the Number of

Channels and Codec used to compress it.

The Video section displays information only in case you load a video file into the program. It includes video file Size, Aspect

Ratio, Frame Rate, Bitrate and the Codec used for video file compression.
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The Tag Info tab contains the list of audio tags that can be edited and saved to output audio file. Audio tags are built-in text

information about audio files such as track name and number, author of the song, its release date etc. It might be useful to fill out the

tag fields, because many audio players use tags rather than file names when playing back audio files.

Fill out the tag fields you consider necessary (all fields are optional). Then press the Save button to accept the changes and close the

File Info window, the Reset button to return to the original tag information or the Close button to discard the changes and close the

window.
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Saving Files

Saving Audio Files

After you edit your audio file you need to save it using one of the available Save options.

To apply all the changes you made to the source file just click the Save  command button on the File Tab or use the same Save

option from the Application Button menu or Quick Access Toolbar.

You can change the format of the edited file when you save it. It can be done to reduce the size of an audio file, to change the number

of channels or to make it possible to playback the file using mobile devices, such as mobile phones, portable players, etc.

To change the file format and save it using this selected format, press the Save as...  command button on the File Tab (the

same Save as... option can be accessed from the Application Button menu or Quick Access Toolbar). The following window will

be opened:

Select the output file format and choose one of the available profiles from the Profile drop-down list. If necessary, you can create your

own profile changing the parameters listed below the Profile field such as Codec used for the audio file compression, Sample Rate

(Frequency), Sample Size, Bitrate, the number of Channels.

Note: some formats, such as AAC, M4A, WMA and WAV allow you to select more than two channels. You can set

up to eight channels depending on your desires and the devices that will be used to playback the resulting audio files.

Note: it is possible to specify Advanced MP3 parameters clicking the appropriate button. You can find the detailed

information about these settings in the Appendix section. See also:

Available MP3 Parameter Combinations

Available MP2 Parameter Combinations
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After you select all the parameters, click the OK button to accept the changes and save the audio file or Cancel to discard the changes

and close this window.

It is also possible to save not the whole file but only the currently selected part of it using the Save Selection as...  button on

the File Tab. If you loaded several files into AVS Audio Editor and would like to save them all, use the Save All  command

button on the File Tab.

Saving Video Files

To save a video file with the edited audio track, press the Save or the Save as...  command button on the File Tab (the same

Save options can be accessed from the Application Button menu or Quick Access Toolbar). The following window will be opened:

Select audio track format and parameters, then click OK to accept the changes and save the video file or Cancel to discard the changes

and close this window. The result will be saved as a video file with the edited audio track of the selected audio format.

Note: AVS Audio Editor sets the path to the original video file in the Save to File field by default. So, if you do

not wish the original file to be affected, press the Browse button and select another directory for your output video

or specify another name for it in the Save to File field.
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Playing and Recording

In AVS Audio Editor you can operate Play and Record as well as other transport functions in the same way as in any standard home

player or recorder. Audio Player Toolbar is situated in the left bottom corner of the Main Window.

 - Click Play to play the portion of the waveform that is currently being viewed, or the portion that is highlighted.

 - Click Pause to pause the playback.

 - Click Stop to end waveform playback.

To adjust the playback volume and balance, press the Options...  button on the Tools Tab. In the opened window switch to the

Playback tab:

Here you can:

select the device used for playback in the Device drop-down list;

adjust the device Balance using the corresponding scroller (move to the left to make the sound play in the left speaker, move

to the right to make it play in the right speaker);

adjust the Volume using the corresponding scroller (move to the left to desrease volume, move to the right to increase

volume).

The Play original sound and Play only stereo options are used to let the player decide how to playback the audio. This might be

useful when you playback a multichannel (5.1 and more channels, for instance) audio on stereo speakers/headphones.

 - Click Record on the Audio Player Toolbar to start recording at the current insertion point.

You can configure your input devices right from AVS Audio Editor, without need to go to the windows Control Panel. To do that,

press the Options...  button on the Tools Tab or use the Advanced  button on the Record Tab. In the opened Options

window switch to the Recording tab. The form that will let you change the device settings will appear:
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In the upper section of the window you can:

select the device that will be used for sound recording and the input jack active on the device. Press the drop-down combo-box

and select the necessary device from the list, if you have more than one input device installed on your computer;

Note: if you use Windows Vista or Windows 7, you'll be able to select both the device and the

input jack in one and the same Input field (the device name and its status being indicated in

brackets). If you run Windows XP, the input device will be displayed in the Device field and the

list of avaiable input jacks will be displayed in the area below.

To view and adjust the input device properties use the Windows recording control button.

Note: if you run Windows Vista or Windows 7, you will be able to enable or disable the selected

device clicking the Windows recording control button. In the opened Sounds window

right-click the necessary device and select the corresponding option from the menu.

set the device Balance - the difference of the sound volume between the right and the left channels;

set the input device Gain - the loudness of the device input;

test the device pressing the Test Input button to make sure that the device is in working order and the Balance and Gain are

set correctly.

In the Recording Mode section you can select between two available options:

Replace original sound - use it to replace any of the audio signal present in the audio file with the recorded audio.

Mix recording with the original sound - use it to mix your recording with the audio signal that's already present in the file.

In the Recording Path section you can select between two available options:

Start recording to a new file - use it to start the recording to a new file. A new file will be created each time you press the

Record button.

Start recording to the current file - use it to record various recording sessions to one and the same file. No new file will be

created when you press the Record button to resume the recording, the recordng will continue to the current file.

Finally, tick/untick the Select recorded audio after the recording is finished and Show every time when the recording starts

options to enable/disable the corresponding features.

After you select all the settings for your input device you can click the OK button to accept the changes made.
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Editing Options

AVS Audio Editor lets the user perform basic editing operations with audio files: copy, paste and delete fragments of audio tracks.

To perform an editing operation please follow these steps:

Double-click the file you would like to edit on the Files and Effects Panel. It will be added to the Waveform Editing Space.1.

Select the part of the audio track that you would like to copy, cut or trim. To do that, click with the mouse where you want the

selection to begin, then drag and release the mouse button at the the end of the selection. The selected area will be highlighted:

2.

Or double-click within the Waveform Editing Space to select the whole audio track.3.

Choose the editing operation you would like to perform with the selected fragment by pressing the corresponding button on the

Edit Tab. Please refer to the appropriate sections to read more on the available edit operations:

Copy operations

Paste operations

Delete and trim operations

4.

You can also add markers to your audio file to mark the important moments and simplify the navigation through the file and convert

sample type of your audio file, changing its Sample Rate, Sample Size and the Number of Channels. See the appropriate

chapters for more detail.
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Copying

The following Copying operations are available in AVS Audio Editor:

 Cut - use this option to cut the currently selected part of the edited audio and copy it to the program internal clipboard.

This option only allows you to cut the selected part of the audio, thus if no part of the audio file has been selected nothing will

be cut and copied. When you cut a part of the audio you can insert it afterwards to some other place of the same audio or to a

different audio, opened in AVS Audio Editor using one of the Paste options.

 Copy - use this option to copy the currently selected part of the edited audio to the program internal clipboard. This

option only allows you to copy the selected part of the audio, thus if no part of the audio file has been selected nothing will be

copied. When you copy a part of the audio you can insert it afterwards to some other place of the same audio or to a different

audio, opened in AVS Audio Editor using one of the Paste options.

Copy to New - use this option to copy the currently selected part of the edited audio to a new file. The new file will be

created automatically and will have the same parameters (sample rate, sample size and the number of channels) as the currently

edited file. This option only allows you to copy the selected part of the audio, thus if no part of the audio file has been selected

nothing will be copied.

Copy to Win Clipboard - use this option to copy the currently selected part of the edited audio to the common windows

clipboard. This option only allows you to copy the selected part of the audio, thus if no part of the audio file has been selected

nothing will be copied. When you copy a part of the audio you can insert it afterwards to some other place of the same audio or

to a different audio, opened in AVS Audio Editor using one of the Paste options. This option is particularly useful when there

are several instances of AVS Audio Editor opened and you would like to copy some audio between them or if you additionally

use some other editor and want to copy audio into it.

Note: all the Copy options are available on the Edit Tab.
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Pasting

The following Pasting operation are available in AVS Audio Editor:

 Paste - use this option to paste (insert) the previously copied audio fragment to the currently edited audio file. It will be

inserted right from the cursor position expanding the file to make it fit the inserted fragment. For instance, if you have a three-

minute file and paste a copied fragment of 20 seconds, the resulting audio will be 3 minutes 20 seconds. If some part of the file

is selected prior to the paste operation, it will be overwritten.

Paste from File - use this option to paste (insert) an audio file to the currently edited audio file. After you select this

option the Open File window will be opened to let you select an audio file. It will be inserted right from the cursor position

expanding the file to make it fit the inserted fragment. For instance, if you have a three-minute file and paste an audio of 20

seconds, the resulting audio will be 3 minutes 20 seconds. If some part of the file is selected prior to the paste operation, it will

be overwritten.

Paste from Clipboard - use this option to paste (insert) the previously copied audio fragment to the currently edited

audio file. This option is particularly useful when there are several instances of AVS Audio Editor opened and you would like to

copy and paste some audio between them or if you additionally use some other editor and want to paste audio from it. It will be

inserted right from the cursor position expanding the file to make it fit the inserted fragment. For instance, if you have a three-

minute file and paste a copied fragment of 20 seconds, the resulting audio will be 3 minutes 20 seconds. If some part of the file

is selected prior to the paste operation, it will be overwritten.

Note: to use this option with more than one instance of AVS Audio Editor you will need to use the Copy

to Clipboard in one of them and Paste to Clipboard in the other, so that the selected fragment could be

available to all the instances of the program.

Paste Mix - use this option to paste (insert) the previously copied audio fragment to the currently edited audio file. It

will be inserted right from the cursor position overwriting the original audio and not changing its duration. For instance, if you

have a three-minute file and paste a copied fragment of 20 seconds, the resulting audio will be still 3 minutes. Before you paste

some audio, you can change the following parameters:

Set Amplify Selected option to change the current audio file or selection amplification in relation to the rest of the audio and

Amplify Paste to set the loudness of the audio in the inserted mix. If some part of the file is selected prior to the paste

operation, the Paste Mix operation will be applied to it only.

Paste Mix from File - use this option to paste (insert) an audio file to the currently edited audio file. After you select this

option the Open File window will be opened to let you select an audio file. It will be inserted right from the cursor position

overwriting the original audio and not changing its duration. For instance, if you have a three-minute file and paste an audio of

20 seconds, the resulting audio will be still 3 minutes. If some part of the file is selected prior to the paste operation, the Paste

Mix operation will be applied to it only.

Note: all the Paste operations can be accessed from the Edit Tab.
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Deleting and Trimming

The following Deleting and Trimming operations are available in AVS Audio Editor:

 Delete - use this option to delete the currently selected fragment of the audio file. This option only allows you to delete

the selected part of the audio, thus if no part of the audio file has been selected nothing will be deleted.

Trim to Selection - use this option to delete the all the audio in the file except the currently selected fragment. It is the

opposite to the simple Delete Selection option. This option only allows you to delete some part of the audio if there is a

selected part, thus if no part of the audio file has been selected nothing will be deleted.

Note: the Delete and Trim to Selection options are available on the Edit Tab.
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Convert Sample Type

To convert the sample-rate, bit resolution, and channel format of an audio file that is currently loaded in AVS Audio Editor into a new

format type (such as 44KHz/16-bit/stereo to 22KHz/8-bit/mono) use the Convert Sample Type command button on the Edit Tab.

Convert Sample Type directly processes samples within the file, or re-samples the data, so that the audio retains the same frequency

and duration as the original file.

Every aspect of conversion can be adjusted to suit your needs. You can set the necessary Sample Rate (8'000 - 96'000 Herz),

Sample Size (8-bit - 32-bit) and the Number of Channels (1/0 - mono -- 3/4+LFE 7.1 surround).

You can also use the advanced options of the resampling clicking the Advanced >> button (it will change into << Simple once it is

pressed). After you open the advanced settings panel of the Convert Sample Type window you will be able to set the following

parameters:

Enable Dither - use this option to apply an intentional form of noise, used to randomize the resampling errors thus preventing

audio distortions. When you choose to enable dither, you can select the type of Probability Density Function (p.d.f.) used -

Triangular, Gaussian, Uniform or Colored differing in type of randomizing in noise creation. It is also possible to change

the Noise Shaping type - A or B - which is not actually dither, but rather a feedback process that has dither within it although

it is used for the same purposes.

High Quality Resampling - use this option to enable the high quality resampling, that will allow you to maximally avoid

distortions. It will take more time and processor power than the sample type conversion without this option enabled.

AVS4YOU Programs Help - AVS Audio Editor

© Online Media Technologies Ltd., UK 2004 - 2011   All rights reserved. www.avs4you.com

Page 62 of  128

http://www.avs4you.com/index.aspx
http://www.avs4you.com/index.aspx


Setting Markers

The markers can be used to mark some moment in the audio to quickly return to it later or mark a selection to quickly copy or delete it.

The current version of AVS Audio Editor allows you to either mark the necessary parts manually or set them automatically using one

of the available options.

To set markers automatically:

click the Auto Markers  button on the Edit Tab.

in the Auto Markers window select one of the available options:

Time Intervals - use this option to set a new marker at the selected time interval measured in

hours:minutes:seconds.milliseconds;

Equal Parts - use this option to specify the number of parts you wish to divide your audio into.

click the Start Marking button to launch the process.

The searching progress bar will be displayed. You can always cancel this process using the appropriate button below the

progress bar. If necessary, you can enable the Warn me that ... new markers are found option.

To set markers manually:

click with the left mouse button within the Waveform Display where you want to set a marker;

press the Add Marker  button on the Edit Tab.

or

double-click the left mouse button within the gray bar between the Display Range Bar and Waveform Display (where the

mouse standard cursor changes into a hand):

The same way a marker for a selection can be set. To do that either select a part of the audio with the mouse and click the Add

Marker  button on the Edit Tab. Or make a selection and double-click the left mouse button within it on the gray bar between

the Display Range Bar and Waveform Display (where the mouse standard cursor changes into a hand):

The set marker will have two boundaries - the first marking the beginning and the second the end of the selection.
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Managing Marker List

To see the whole list of the set markers and manage them use the Marker List. Press the View Marker List  command button

on the File Tab to open it:

Here you can:

merge several markers;

Use the left mouse button and the Shift or Ctrl keys on the keyboard to select a group of markers or separate markers on the

list. Click the Merge Selected button to join the selected marked fragments together.

select several markers to playback them;

Use the left mouse button and the Shift or Ctrl keys on the keyboard to select a group of markers or separate markers on the

list. Click the Play Selected button to playback them (the Play Selected button will turn into Stop once you press it to let

you stop playback).

save the set markers to file;

Click the Save to File button to save the whole list of the set markers into a .xml file to be able to use this information next

time you need to edit your audio.

add the markers from file;

Click the Add from File button to load the list of the set markers from the previously saved .xml file.

add marker properties;

In the right part of the Marker List window more marker properties can be entered manually: Label - to give a marker a more

meaningful name, Begin and End to precisely alter the marker initial and final limit, Length to change the length of the

markers selection and Description to give a marker a wider description so that you could understand later what this exact

marker has been set for.

add, edit and delete markers;

Click the Add button to create a new marker, Change to edit the current marker or Delete to remove the current marker from

the Marker List and from the audio.

When you have finished with the marker editing, press the Done button to save the changes and close the Marker List window.
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Splitting by Markers

The markers can be used to split the audio file into several separate ones. To do that set the markers to the necessary places (refer to

the Setting Markers chapter) and click the Split File by Markers  button on the File Tab.

The audio file will be divided into several ones that will begin and end at the points where the markers are placed. They will be named

as File Name + the order number and put to the Files tab of the Files and Effects Panel:

After that you can edit each of the resulting files individually.
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Editing Individual Channels

Normally all channels of the audio file are edited simultaneously. You can, however, edit channels independently by disabling the one or

several of them. To do so, use the Control key of the keyboard together with the mouse pointer (the cursor will acquire L or R letter)

and left-click to enable only the necessary channel for editing (the disabled channels will gray-out), another left-click within the disabled

channel will re-enable it.

The possible cursor values include (for 8-channel audio, for instance):

Lf - Left front channel

Rf - Right front channel

Cf - Central front channel

LFE - Low-Frequency Effects (subwoofer) channel

Lr - Left rear channel

Rr - Right rear channel

Ls - Left surround channel

Rs - Right surround channel

Applying Effects to Individual Channels

You may apply a limited number of effects to individual channels. Effects that change the audio track duration or resample it will be

applied to all audio channels regardless of whether they are disabled or not.

The following effects will be applyed to all audio channels:

Tempo Change

Pitch Shift

Rate Change

Reverse

Voice Morpher

Pasting in Individual Channels

When pasting, the audio data is always overlapped with what is already there, since inserting only in one channel will put the channels

completely out of phase.
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Applying Effects and Filters

The main audio editing options of the AVS Audio Editor include:

Amplitude effects

Delay/Modulation effects

Time Stretch/Pitch Shift effects

Filters

DX Filters

VST effects

All of them are available on the Effects Tab or on the Files and Effects Panel.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. To apply an audio effect or filter to your audio file, follow these

steps:

Add the audio file to the Waveform Editing Space.1.

Select the part of the file you would like to apply the effect to. Leave it unselected to apply the effect to the whole file.2.

Click the needed effect or filter button on the Effects Tab or double-click the effect on the Files and Effects Panel.3.

Set the effect parameters in the opened window.

Note: if you change the effect settings, you can save them as a preset to be able to use them afterwards.

Use the Add button to do that.

4.

Click the Preview button to make sure that the changes are correct.5.

Click the OK button to apply the effect with the selected parameters and go back to the audio file editing.6.
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Amplitude Effects

The Amplitude effects allow you to increase or decrease the volume of an audio file or selection.

Effect Description

Amplify Increases or decreases the sound volume by means of increasing or decreasing its amplitude

Fade In/Out Increases or decreases the sound volume gradually

Normalize Increases or decreases the sound to the selected volume level

Envelope
Increase the volume of some specific fragments of an audio track and decreases the sound volume of

other fragments

Compressor Reduces the dynamic range of an audio signal

Multiband

Compressor
Reduces the dynamic range of an audio signal acting independetly on the high and low frequency bands

Mute Turns of the sound of an audio track or the selected part of it

Invert Inverts the sound around the horizontal axis

Limiter Reduces peaks and spikes and limits the amplitude of an audio signal

Auto Correction
Enhances the sound aural characteristics reducing the dynamic range, normalizing and equalizing an audio

track
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Amplify

The Amplify effect is used to increase or decrease the volume of the sound by means of increasing or decreasing its

amplitude.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Amplify Settings - Simple Mode

The Simple mode allows to amplify/attenuate an audio signal and visually check the results on a waveform. The applied amplification

will equally affect all sound channels of the edited file.

Use the slider of the Amplification scale to set the desired amplification of your audio file in dB. Alternatively, enter the desired

amplification (gain) value in the box next to the scale.

Setting a positive value will increase the sound volume of your audio file, setting a negative value will descrease sound volume. The

more the set value (positive or negative) is, the more the resulting volume will be increased or decreased.

Amplify Settings - Advanced Mode

The Advanced mode allows to apply the Amplify effect individually to each sound channel. For this purpose there is a separate

Amplify slider available for each channel.
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To set the desired amplification for a particular channel, use the corresponding slider or box. The setting is done in the same way as in

the Simple mode (see above).

If you enable the Link sliders option, all sliders will change their position to that of the upper slider. With this option enabled, moving

any slider will also move the rest of the sliders to the same position.

If a channel is not selected in the Waveform Editing Space, its respective slider will be disabled on the Advanced tab.

Note: The settings of the Simple and Advaned tabs can be changed independently. When you apply or preview

the effect, the settings of the active tab are used.
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Fade In/Fade Out

The Fade In and Fade Out effects are usually used to smooth the boundaries of an audio track. Use the Fade In effect to

gradually increase the sound volume. Use the Fade Out effect to gradually decrease the sound volume.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Fade In/Fade Out Settings

You may adjust the following parameters in the Fade In/Fade Out settings window:

First select whether you want to apply the Fade In or Fade out effect by pressing the corresponding button. Next select one of the

four fade types from the drop-down list:

linear - use it to evenly increase or decrease the sound volume;

slow - use it to slowly increase or decrease the sound volume;

fast - use it to quickly increase or decrease the sound volume;

smooth(selected by default) - use it to smoothly increase or decrease the sound volume.

The selected sline graph is displayed in the settings window so you may visually judge the way the sound of your audio file will be

changed.
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Normalize

The Normalize effect is used to even the volume of an audio track in accordance with the selected level.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Normalize Effect Settings

The software will define the maximum level of the audo signal and calculate the ratio by which this maximum signal should be

amplified/attenuated in order to fit the specified Normalize to level. If the maximum sound level of the audio file is above the specified

Normalize to level, then the rest of audio will be attenuated by the same ratio. If the maximum sound level of the audio file is below

the specified Normalize to level, then the rest of audio will be amplified by the same ratio.

The following Normalize effect parameters are available for editing:

Normalize to - sets the maximum level of the output signal. If you set it to 100%, the maximum level of the input signal will

be amplified so as to reach the maximum level of amplitude that AVS Audio Editor can produce without clipping. Setting it to

0% will mute the original audio completely.

Equal gain for channels - tick this option to apply one and the same gain ratio to all channels. Enable this option to avoid

changes in the stereo balance of the output audio.

Remove DC Offest - tick this option to remove DC offset. Enable this option if the DC offset is present in the original file. The

offset presence can be visually noticed on the waveform view: if an audio track is not centered along the horizontal line, it is

advisable that the Remove DC Offest option is used to remove the offset.
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Envelope

The Envelope effect allows you to increase the volume of some specific fragments of an audio track and decrease the sound

volume of other fragments. It is usually used to smooth the beginning or end of audio tracks. It is also useful for creating

audio loops and samples.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Envelope Settings

The Envelope effect is achieved by changing the audio file amplitude in accordance with the specified coordinates. To modify the

amplitude, please use the following settings:

use the envelope scale to set the maximum output level. If you set the scale to 400% with the envelope line going along the

top, this will make the output sound 4 times as loud as the original. If you zoom in the scale up to 100%, the maximal output

volume will correspond to the orginal, and you will be able only to decrease the output volume.

use envelope points to modulate the volume of an audio track. To add a point, double-click on the envelope line. To delete a

point, drag it anywhere beyond the limits of the waveform display. Drag the point upwards to amplify the original sound. Drag it

downwards to decrease the sound volume.

check the Spline option to smooth the envelope graph.
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Compressor

The Compressor effect is used to reduce the dynamic range of an audio signal - make quiet sounds louder, and loud sounds

quieter. AVS Audio Editor will apply the Compressor effect along with the Noise Gate filter. This will help get rid of

unnecessary noise by eliminating audio signal below the specified threshold.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Compressor Settings

The Compressor effect allows to configure the following parameters:

Compressor Parameters

The following compressor parameters are available for editing:

Threshold - the level (in dB) at which the compressor becomes active. The

compressor will affect only the sound above the specified threshold.

Ratio - the amount of compression of the output signal in relation to the input

audio. Setting the compression ratio to 1:1 will produce no compression effect. If

you set ratio to 1:3 and threshold to -20, a -2 dB sound will be compressed

down to -14 dB (the difference between -20 and -2 will be divided by 3).

Attack Time - the period during which the compressor becomes active and

decreases gain till it reaches the specified ratio.

Release Time - the period during which the compressor remains active once

the sound has fallen below the threshold.

Note: the attack and release times are used to smooth the compressor boundaries. The slower the attack

and release are, the smoother the transition between affected and non-affected signal will be.

Noise Gate Parameters

The following Noise Gate parameters are available for editing:

Threshold - the level (in dB) at which the gate opens. The noise gate filter will

affect only the sound below the specified threshold.

Attack Time - the amount of time it takes the noise gate to change from closed

to open once the signal exceeds the specified threshold.

Release Time - the period during which the noise gate remains open once the

signal has fallen below the specified threshold.

Note: the attack and release times are used to smooth the noise gate boundaries. The slower the attack

and release are, the smoother the transition between affected and non-affected signal will be.
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General Options

The following general parameters are available for editing:

Post-Amplify - the amount of post-amplification used after the compressor has

been applied. This will allow you to restore the original sound level after applying

the compressor.

RMS/Peak - a method of measuring the sound level. Tick the corresponding

radiobutton to select the desired method.

Equal gain for channels - allows to synchronize channels; the compression

and noise suppression ratios, as well as the moments of noise gate opening will

be the same for all channels.
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Multiband Compressor

The Multiband Compressor effect is a specific type of the Compressor effect. But unlike the Compressor effect the

Multiband Compressor is applied independently to the high and low frequency bands of the audio. It is used to reduce

pumping and make your recording sound more equal. AVS Audio Editor will apply the Multiband Compressor effect along

with the Noise Gate filter. This will help get rid of unnecessary noise by eliminating audio signal below the specified threshold.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Multiband Compressor Settings

The Multiband Compressor splits the audio track into two frequency bands and then compresses each band separately. In other

words the software will divide your audio into the high and low frequency bands by the Crossover Frequency you specify, compress

each band based on the parameters you set for the Low Frequency Compression and the High Frequency Compression

respectively and then recombine the outputs.

The following Multiband Compressor effect parameters are available for editing:

use the Crossover Frequency slider to define the frequency by which the input audio will be divided into two bands.

tick the Low Frequency Compressor option to enable the low frequency compressor. To learn more about the available

compressor parameters refer to the Compressor Parameters section below.

tick the High Frequency Compressor option to enable the high frequency compressor. To learn more about the available

compressor parameters refer to the Compressor Parameters section below.

tick the Noise Gate Parameters option to enable the noise gate filter to get rid of unnecessary noise. To learn more about the

available noise gate parameters refer to the Noise Gate Parameters section below.
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Compressor Parameters

The following compressor parameters are available for editing:

Threshold - the level (in dB) at which the compressor becomes active. The

compressor will affect only the sound above the specified threshold.

Ratio - the amount of compression of the output signal in relation to the input

audio. Setting the compression ratio to 1:1 will produce no compression effect. If

you set ratio to 1:3 and threshold to -20, a -2 dB sound will be compressed

down to -14 dB (the difference between -20 and -2 will be divided by 3).

Attack Time - the period during which the compressor becomes active and

decreases gain till it reaches the specified ratio.

Release Time - the period during which the compressor remains active once

the sound has fallen below the threshold.

Note: the attack and release times are used to smooth the compressor boundaries. The slower the attack

and release are, the smoother the transition between affected and non-affected signal will be.

Noise Gate Parameters

The following Noise Gate parameters are available for editing:

Threshold - the level (in dB) at which the gate opens. The noise gate filter will

affect only the sound below the specified threshold.

Attack Time - the amount of time it takes the noise gate to change from closed

to open once the signal exceeds the specified threshold.

Release Time - the period during which the noise gate remains open once the

signal has fallen below the specified threshold.

Note: the attack and release times are used to smooth the noise gate boundaries. The slower the attack

and release are, the smoother the transition between affected and non-affected signal will be.

General Options

The following general parameters are available for editing:

Post-Amplify - the amount of post-amplification used after the multiband

compressor has been applied. This will allow you to restore the original sound

level after applying the compressor.

RMS/Peak - a method of measuring the sound level. Tick the corresponding

radiobutton to select the desired method.

Equal gain for channels - allows to synchronize channels; the compression

and noise suppression ratios, as well as the moments of noise gate opening will

be the same for all channels.
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Mute

The Mute effect is used to switch off the sound in the edited audio file.

How to Apply

Add the audio file to the Waveform Editing Space.1.

Select the part of the file you would like to apply the effect to. Leave it unselected to apply the effect to the whole file.2.

Click the Mute button on the Effects Tab or double-click the Mute effect on the Files and Effects Panel.3.

Wait while the progam applies the effect. Click Cancel at any time to abort the process.4.

Settings

This effect does not have any settings and will be simply applied so that either the selected part of the audio file will be muted or the

whole audio if nothing has been selected.

AVS4YOU Programs Help - AVS Audio Editor

© Online Media Technologies Ltd., UK 2004 - 2011   All rights reserved. www.avs4you.com

Page 78 of  128

http://www.avs4you.com/index.aspx
http://www.avs4you.com/index.aspx


Invert

The Invert effect inverts the sound around the horizontal axis. Usually this effect is used to change the polarity of one of the

stereo channels in order to put them in phase. For more information, please refer to the Phase Analysis page.

How to Apply

Add the audio file to the Waveform Editing Space.1.

Select the channel you would like to apply the effect to by using the Control key of the keyboard together with the mouse

pointer (the cursor will acquire L or R letter) and left-clicking.

2.

Click the Invert button on the Effects Tab or double-click the Invert effect on the Files and Effects Panel.3.

Wait while the progam applies the effect. Click Cancel at any time to abort the process.4.

Settings

This effect does not have any settings and will be simply applied so that either the selected channel will be inverted or the whole audio

if nothing has been selected.
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Limiter

The Limiter effect is a special type of the Compressor effect characterized by a high compression ratio and a fast attack

time. It is used to reduce peaks and spikes and limits the amplitude of an audio signal.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Limiter Settings

The Limiter effect allows to configure the following parameters:

Threshold - the level (in dB) at which the limiter becomes active. The limiter will reduce the picks above the specified

threshold.

Post-Amplify - the amount of post-amplification used after the limiter has been applied. This will allow you to restore the

original sound level after applying the limiter.

Equal gain for channels - this option allows you to apply one and the same gain ratio to all channels. Enable it to avoid

changes in the stereo balance of the output audio.
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Auto Correction

The Auto Correction effect is used to automatically enhance the sound quality, its aural characteristics reducing the dynamic

range, normalizing and equalizing your audio track.

How to Apply

Add the audio file to the Waveform Editing Space.1.

Select the part of the file you would like to apply the effect to. Leave it unselected to apply the effect to the whole file.2.

Click the Auto Correction button on the Effects Tab or double-click the Auto Correction effect on the Files and Effects

Panel.

3.

Wait while the progam applies the effect. Click Cancel at any time to abort the process.4.

Settings

This effect does not have any settings and will be simply applied to enhance the quality of the selected part of the audio file or the

whole audio if nothing has been selected.
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Delay/Modulation Effects

The Delay/Modulation effects allow you to add an echo to your audio, create the pulsating sound or change the voice of an audio file

or selection.

Effect Description

Echo Repeats the sound after the selected delay

Chorus Makes the audio sound fuller

Flanger Adds an echo to the audio by means of changing the frequency of the repeated sound

Phaser Adds an echo to the audio by means of changing the phase of the repeated sound

Reverb Simulates the acoustical effect of rooms and enclosed buildings

Vibrato Creates an effect of pulsating sound

Voice Morpher Transforms and converts the voice to make it sound as if it were spoken by another speaker

AVS4YOU Programs Help - AVS Audio Editor

© Online Media Technologies Ltd., UK 2004 - 2011   All rights reserved. www.avs4you.com

Page 82 of  128

http://www.avs4you.com/index.aspx
http://www.avs4you.com/index.aspx


Echo

The Echo effect allows you to create an echo effect of your audio track by replaying the sounds of the selected audio portion

after a certain period of time.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Echo Settings

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following Echo settings are available for editing:

Echo Level - defines the delayed sound volume level in relation to the original sound. If you set it to 100%, the original sound

and its echo will have equal volume. If you set it to 0, no echo will be heard at all.

Delay Time - sets the point in milliseconds at which echo starts behind the original signal. The minimal delay time is 100 ms. If

you set a bigger value, the distance between the original and delayed sound will grow.

Feedback - determines how much of the affected sound is sent back to the input to be processed again. Use it for multiple

echoes.
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Chorus

The Chorus effect allows you to make your audio sound fuller. It can make a single instrument sound like there are actually

several instruments being played or the recording of a vocal track sound like it was sung by two or more people singing in

chorus.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Chorus Settings

The Chorus effect is achieved by adding one or more delayed signals to the original input. To apply the effect, use one of the available

presets or configure the effect parameters manually.

The following Chorus settings are available for editing:

Dry/Wet Balance - sets the amout of the affected sound as related to the original. The parameter values vary between 0%

and 100%. If you set the balance to 50%, the original and affected sound will be mixed in equal proportions. Setting it to

100% will mute the original sound, setting it to 0% will mute the affected sound.

Delay Time - sets the point in milliseconds at which echo starts behind the original signal. The default delay time is 10 ms. If

you set a bigger value, the distance between the original and delayed sound will grow.

Voices - defines the number of delayed signals that will be added to the original audio. A duplicate delay time is used for the

second voice, a triple value is used for the third voice etc.

Modulation Depth - controls the degree of delay time change. This parameter sets the limits within which the delay varies.

The modultion depth values may vary from 0% to 100%. Setting the parameter to 0% will result in a constant delay time.
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Setting it to 100% will make the delay time change from its original value (the one you set in the Delay Time field) to a

duplicate Delay Time value.

Modulation Rate - sets the number of delay time variations, in Hertz. This parameter controls how often the delay time

oscillates. For example, if you set the parameter to 3 Hz, it means that the delay time will oscillate (make the full cycle from the

smallest to the biggest delay value and back to the smallest) 3 times per second.

Stereo Rotation - sets the left and right delays at separate values, creates a stereo rotation effect. The parameter values vary

from 0% to 100%: 0% means no rotation; 100% corresponds to maximum stereo rotation effect.
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Flanger

The Flanger effect is a special case of the Chorus effect: it is created in the same way as Chorus. Flanging used to be created

by putting a finger onto the tape reel's flange, thus slowing it down. Two identical recordings are played back simultaneously,

and one is slowed down to give the flanging effect. Flanger gives a "whooshing" sound, like the sound is pulsating. It is

essentially an exaggerated Chorus.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Flanger Settings

The Flanger effect is achieved by mixing a signal with a slightly delayed copy of itself, where the length of the delay is constantly

changing. To apply the effect, use on the available presets or configure the effect parameters manually.

The following Flanger settings are available for editing:

Dry/Wet Balance - sets the amout of the affected sound as related to the original. The parameter values vary between 0%

and 100%. If you set the balance to 50%, the original and affected sound will be mixed in equal proportions. Setting it to

100% will mute the original sound, setting it to 0% will mute the affected sound.

Delay Time - sets the point in milliseconds at which echo starts behind the original signal. The default delay time is 10 ms. If

you set a bigger value, the distance between the original and delayed sound will grow.

Feedback - determines how much of the affected sound is sent back to the input to be processed again.
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Modulation Depth - controls the degree of delay time change. This parameter sets the limits within which the delay varies.

The modulation depth values may vary from 0% to 100%. Setting the parameter to 0% will result in a constant delay time.

Setting it to 100% will make the delay time change from its original value (the one you set in the Delay Time field) to a

duplicate Delay Time value.

Modulation Rate - sets the number of delay time variations, in Hertz. This parameter controls how often the delay time

oscillates. For example, if you set the parameter to 3 Hz, the delay time will oscillate (make the full sycle from the smallest to the

biggest delay value and back to the smallest) 3 times per second.

Stereo Rotation - sets the left and right delays as separate values, creates a stereo rotation effect. The parameter values vary

from 0% to 100%: 0% means no rotation; 100% corresponds to maximum stereo rotation effect.

Invert - inverts the affected sound when mixing it with the original.
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Phaser

The Phaser effect is generally used to give electronic effect to natural sounds.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Phaser Settings

The phaser effect is created by means of passing a band of frequencies through a phase shifter and then mixing them with the original

audio signal. The original and affected signals, when mixed, will cancel each other and create a notch if they are out of phase. If,

however, they are partially out of phase, then partial cancellations occur. The phase shifter will change the phase of the signal by 180°

at its center notch frequency (thus, putting the original and affected sound out of phase and cancelling them). The band of frequencies

around the center notch frequency that will be affected by the phase shifter is determinaed by the Q factor.

Sweeping Band - determines the notch frequency oscillation range (the lowset and the highest notch frequency oscillation

limits).

Dry/Wet Balance - sets the amout of the affected sound as related to the original. The parameter values vary between 0%

and 100%. If you set the balance to 50%, the original and affected sound will be mixed in equal proportions. Setting it to

100% will mute the original sound, setting it to 0% will mute the affected sound.

Modulation Rate - sets the number of oscillations of the notch frequency per second. This parameter controls how often the

notch frequency oscillates. For example, if you set the parameter to 3 Hz, the notch frequency will oscillate (make the full cycle

from the lowest to the highest frequency value and back to the lowest) 3 times per second.

Stereo Rotation - sets the left and right notch frequencies at separate values, creates a stereo rotation effect. The parameter

values vary from 0% to 100%: 0% means no rotation; 100% corresponds to maximum stereo rotation effect.

Q Factor - determines the range of frequencies affected by the phase shifter. The bigger the value, the narrower the notch

frequency band is.
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Reverb

The Reverberation filter helps you apply a particular effect when the sound stops but the reflections continue, decreasing in

amplitude, until they can no longer be heard. The Reverb effect is used to simulate the acoustical effect of rooms and

enclosed buildings.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Reverb Settings

To apply the effect, use on the available presets or configure the effect parameters manually.

The following Reverb effect parameters are avialable for editing:

Original - sets the amplification value of the original audio signal that will be present in the output audio.

Reverberation - sets the amplification value of the reverberated audio signal that will be present in the output audio.

Reverb Length - defines the amount of time it takes the reverberations to fade out (decrease their amplitude gradually by 60

dB).

Pre-Delay - sets the point in milliseconds at which reverberation starts behind the original signal. You may think of it as the

time it takes the audio signal to reach the imaginary "wall" and start being reflected from it. Setting bigger values will simulate

reverberations in a bigger room.

Echo Frequency Band - sets the frequency range that will be processed and reverberated. Frequencies beyond this range will

not be affected.
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Vibrato

The Vibrato effect creates an effect of pulsating sound.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Vibrato Settings

The Vibrato effect is achieved by a periodical variation in the sound amplitude. To apply the effect, use on the available presets or

configure the effect parameters manually.

The following Vibrato settings are available for editing:

Depth - determines the amplitude variation limits. The bigger the value, the wider the amplitude variation range will be. Thus,

setting depth to 100% will make the sound amplitude oscillate between silence and the maximum amplitude of the sound in

your audio track. Setting it to 0% will result in no vibration at all.

Rate - sets the number of amplitude oscillations per second. This parameter controls how often the sound amplitude oscillates.

For example, if you set the parameter to 3 Hz, the amplitude will oscillate (make the full sycle from the minimum to the

maximum amplitude and back to the minimum) 3 times per second.
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Voice Morpher

The Voice Morpher effect is used to transform and convert the voice to make it sound as if it were spoken by another

speaker (a cartoon or a monster voice).

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Voice Morpher Settings

The following Voice Morpher settings are available for editing:

Flanger - applies a flanger effect making the voice tremble. The parameter values vary from 0% to 100%: 0% means no

trembles; 100% corresponds to maximum flanging effect.

Pitch Shift - changes the sound pitch (tone) without changing its tempo. The lower the value, the lower the pitch will be. The

parameter values vary from 0.5 to 2: 1 means no pitch change.

Tempo - changes the tempo but keep the pitch the same throughout. The audio will play slower or faster, but its tone will

remain unchanged. The parameter values vary from 0.5 to 2: 1 means no tempo change.

Reverberation - applies a reverberation effect creating an echo and simulating the acoustic hall effect. The parameter values

vary from 0% to 100%: 0% means no effect applied.
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Time Stretch/Pitch Shift Effects

The Time Stretch/Pitch Shift effects allow you to increase or decrease the speed and the tone of your audio or make a selection play

backwards.

Effect Description

Tempo Change Changes the tempo keeping the pitch the same throughout the audio file

Pitch Shift Changes the sound pitch (tone) without changing its tempo

Rate Change Changes the speed and tone of the sound

Reverse Produces an effect similar to backward playback
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Tempo Change

The Tempo Change (also called Time Stretch) effect allows to change the tempo, but keep the pitch the same throughout.

The audio will play slower or faster, but its tone will remain unchanged.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Tempo Change Settings

Use the Ratio text field or the wheel cursor to set the desired tempo change level. Setting the parameter to 100% will correspond to

the original sound. Values below 100% will cause the tempo to decrease. Values above 100% will cause the tempo to increase.
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Pitch Shift

The Pitch Shift effect shifts the frequency spectrum of the input signal. This will change the sound pitch (tone) without

changing its tempo.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Pitch Shift Settings

Use the drop-down list to the right to select between the pitch shift types.

Select Semitones to shift the sound pitch by semitones. Next use the Ratio text field or the wheel cursor to set the desired pitch

change level. Setting the parameter to 0.00 will correspond to the pitch of the original sound. Values below zero will cause the pitch to

decrease. Values above zero will cause the pitch to increase. For example, if you set the ratio to 2.00, the resulting audio musical key

will be raised by 2 semitones.

Select Ratio to shift the sound pitch by percentage. Next use the Ratio text field or the wheel cursor to set the desired pitch change

level. Setting the parameter to 100% will correspond to the pitch of the original sound. Values below 100% will cause the pitch to

decrease. Values above 100% will cause the pitch to increase.
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Rate Change

The Rate Change effect allows you to simultaneously change the sound tempo and pitch. Decreasing the rate value will

cause the tempo and pitch to decrease. Increasing it will cause the tempo and pitch to increase.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Rate Change Settings

Use the Ratio text field or the wheel cursor to set the desired pitch/tempo change level. Setting the parameter to 100% will correspond

to the original sound. Values below 100% will cause the tempo and pitch to decrease. Values above 100% will cause the tempo and

pitch to increase.
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Reverse

The Reverse effect is used to make a selection play backwards by reversing the order of its samples. It creates an effect of

reverse (backward) playback. It is also useful for creating special effects.

How to apply

Add the audio file to the Waveform Editing Space.1.

Select the part of the file you would like to apply the effect to. Leave it unselected to apply the effect to the whole file.2.

Click the Reverse button on the Effects Tab or double-click the Reverse effect on the Files and Effects Panel.3.

Wait while the progam applies the effect. Click Cancel at any time to abort the process.4.

Settings

This effect does not have any settings and will be simply applied so that either the selected part will be reverted or the whole audio if

nothing has been selected.

Note: On multichannel (containing two and more channels) waveforms, all channels are reversed.
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Filters

The Filters allow you to amplify/attenuate frequencies, reduce or increase the intensity and eliminate noise and moments of silence

from your audio track.

Filter Description

Equalizer Changes the frequency pattern of the audio file, attenuates some of the frequencies and amplifies others

Parametric Filters

Amplify/attenuate frequencies below/above the selected level or within the selected frequency range.

The Parametric Filters group includes:

Pass filters: High-Pass and Low-Pass

Band filters: Band-Pass and Band-Stop

Notch/Resonance filters: Resonance and Notch

FFT Filter Reduces or increases the intensity of a specific frequency in accordance with the selected profile

Delete Silence Detects and removes moments of silence from an audio track

Noise Gate Eliminates noise below the selected level

Noise Removal Reduces noise making the sound clearer
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Equalizer

The Equalizer filter is used to change the frequency pattern of the audio file, attenuate some of the frequencies and amplify

others.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Equalizer Settings

To apply the effect, select the number of frequency bands you would like to amplify/attenuate and then specify the desired amplification

value for each frequency by moving the sliders of the vertical bars.

Use the Settings drop-down list to set the number of frequency bands you want to affect. You may select between 10 and 20 bands.

The whole frequency range will be divided into 10 or 20 bands with the center frequency of each band indicated above its

corresponding vertical bar. Selecting 20 bands will display more frequency bands which will help you build a more accurate equalization

curve.

Use the sliders of the vertical bars with numbers to amplify/attenuate a particular frequency band. The software will allow you to

amplify/attenuate each frequency band by a maximum of 20 dB. The current amplification/attenuation value will be displayed below the

bar. You may also click the number and enter the needed value form the keyboard.

Use the Gain slider to the right to amplify/attenuate the whole audio track. The software will allow you to amplify/attenuate the audio

signal by a maximum of 20 dB. Setting a positive value will amplify the sound, setting a negative value will attenuate it.
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Parametric Filters

Parametric filters are used to amplify/attenuate frequencies below/above the selected level or within the selected frequency range. The

effects of this group are usually used to correct various imperfections in the original sound.

The Parametric Filters group includes:

Pass filters: High-Pass and Low-Pass

Band filters: Band-Pass and Band-Stop

Notch/Resonance filters: Resonance and Notch
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High-Pass Filter

The High-Pass filter is used to attenuate frequencies below the cutoff frequency. Like all parametric filters, this one is usually used to

correct various imperfections in the original audio.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

High-Pass Filter Settings

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following High-Pass filter settings are available for editing:

Cutoff Frequency - sets the frequency point at which the whole frequency range will be divided into 2 bands – pass-band and

stop-band. All frequencies below the Cutoff Frequency will be attenuated in accordance with the attenuation curve. All

frequencies above the Cutoff Frequency will not be affected by the filter.

Gain - sets the degree of amplification applied to the audio signal. Use it if you want to increase/decrease the resulting sound

volume. The amplification will affect frequencies in both the pass- and stop-bands.

Limit Suppression by - tick this option to limit the attenuation curve decay (lower shelf). The attenuation will stop at this point

and the signal will not fall below this level.

Slope - sets the steepness of the frequency attenuation curve. Use it to control the transition between the affected and

non-affected frequencies. Higher values correspond to a higher attenuation growth in the stop-band.
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Low-Pass Filter

The Low-Pass filter is used to attenuate frequencies above the cutoff frequency. Like all parametric filters, this one is usually used to

correct various imperfections in the original audio.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Low-Pass Filter Settings

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following Low-Pass filter settings are available for editing:

Cutoff Frequency - sets the frequency point at which the whole frequency range will be divided into 2 bands – pass-band and

stop-band. All frequencies above the Cutoff Frequency will be attenuated in accordance with the attenuation curve. All

frequencies below the Cutoff Frequency will not be affected by the filter.

Gain - sets the degree of amplification applied to the audio signal. Use it if you want to increase/decrease the resulting sound

volume. The amplification will affect frequencies in both the pass- and stop-bands.

Limit Supression by - tick this option to limit the attenuation curve decay (lower shelf). The attenuation will stop at this point

and the signal will not fall below this level.

Slope - sets the steepness of the frequency attenuation curve. Use it to control the transition between the affected and

non-affected frequencies. Higher values correspond to a higher attenuation growth in the stop-band.
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Band-Pass Filter

The Band-Pass filter is used to pass frequencies within the selected range and attenuate frequencies outside this range. Like all

parametric filters, this one is usually used to correct various imperfections in the original audio.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Band-Pass Filter Settings

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following Band-Pass filter settings are available for editing:

Frequency Band - sets the frequency band which will not be affected by the filter. In other words, all frequencies outside the

specified frequency band will be attenuated. Once a frequency goes beyond the specified frequency band limits, its amplitude

will gradually decrease till it has no amplification (the signal will be very weak, or non-existant), unless you limit the supression

level in the Limit Supression by field.

Gain - sets the degree of amplification applied to the audio signal. Use it if you want to increase/decrease the resulting sound

volume. The amplification will affect frequencies in both the pass and attenuation bands.

Limit Supression by - tick this option if you do not wish the frequency attenuation to reach its zero amplitude. Set the signal

level in decibels at which the frequency attenuation will stop.

Slope - sets the frequency attenuation rate. Use it to control the transition between the affected and non-affected frequencies.

Higher values correspond to a sharper transition.
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Band-Stop Filter

The Band-Stop filter is used to attenuate frequencies within the selected range and pass frequencies outside this range. Like all

parametric filters, this one is usually used to correct various imperfections in the original audio.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Band-Stop Filter Settings

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following Band-Stop filter settings are available for editing:

Frequency Band - sets the frequency band within which the attenuation will take place. In other words, all frequencies outside

the specified frequency band will not be affected by the filter. Once a frequency reaches the specified frequency band limits, its

amplitude will gradually decrease till it has no amplification (the signal will be very weak, or non-existant), unless you limit the

supression level in the Limit Supression by field.

Gain - sets the degree of amplification applied to the audio signal. Use it if you want to increase/decrease the resulting sound

volume. The amplification will affect frequencies in both the pass and attenuation bands.

Limit Supression by - tick this option if you do not wish the frequency attenuation to reach its zero amplitude. Set the signal

level in decibels at which the frequency attenuation will stop.

Slope - sets the frequency attenuation rate. Use it to control the transition between the affected and non-affected frequencies.

Higher values correspond to a sharper transition.
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Notch Filter

The Notch filter is used to attenuate the selected frequency and its harmonics. Like all parametric filters, this one is usually used to

correct various imperfections in the original audio.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Notch Filter Settings

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following Notch filter settings are available for editing:

Frequency - sets the notch frequency (the one you want to attenuate).

Bandwidth - specifies the band of frequencies around the notch frequency that will be affected by the filter in percent. The

bigger the value, the wider the band.

Suppress Harmonics - tick this option to suppress the notch frequency harmonics. The program will eliminate a maximum of

4 harmonics. Suppressing harmonics will help eliminate unwanted hum.
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Resonance

The Resonance filter is used to amplify/attenuate the selected frequency by a given level. Like all parametric filters, this one is usually

used to correct various imperfections in the original audio.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Resonance Filter Settings

Many of non-advanced musical instruments and acoustic systems tend to have unwanted resonances. If you discover such unwanted

effect in your instrument, you'll be able to use Frequency Analisys to define the resonance frequency of you instrument and then

attenuate it with the help of the Resonance filter.

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following Resonance filter settings are available for editing:

Frequency - sets the resonance frequency (the one you want to amplify/attenuate).

Bandwidth - specifies the band of frequencies around the resonance frequency that will be affected by the filter in percent. The

bigger the value, the wider the band.

Gain - sets the level in decibels by which you want the resonant frequency to be amplified/attenuated.
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FFT Filter

The FFT (Fast Fourier Transform) Filter allows to reduce or increase the intensity of the frequency in accordance with the

selected frequency profile. The filter smoothes the signal during a time in limits of the FFT block. It is recommended to use

the filter in the following cases: for the extreme filtering - when the processing result as a fact is more important then the

possible smoothing effect; for the cutting of the specified frequencies. If you select a part of the file with the mouse, this effect will be

applied to this exact part of the file. Otherwise the sound of the whole file will be affected.

To apply the effect you should do the following:

Add the audio file to the Waveform Editing Space.1.

Select a part of the file you would like to apply the effect to or leave it unselected to apply the effect to the whole file.2.

Click the FFT Filter button on the Effects Tab or double-click the FFT Filter on the Files and Effects Panel.3.

Adjust the effect parameters or select one of the available presets from the list.

Note: if you change the effect settings, you can save them as a preset to be able to use them afterwards.

Use the Add button to do that.

4.

Click the Preview button to make sure that the changes are correct.5.

Click the OK button to return to the audio file editing.6.
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Delete Silence

The Delete Silence filter is used to detect and remove moments of silence from an audio track. You will need to tell the

program what exactly to consider moments of silence by setting the corresponding parameters in the settings window (see

below).

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Delete Silence Settings

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following Delete Silence settings are available for editing:

Silence is below - sets the strength of the signal in decibels.

For more than - sets the duration of audio signal in milliseconds.

All audio signal below the level set in the "Silence is below" field whose duration excceds the value set in the "For more than" field will

be treated as silence and removed from your audio track.
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Noise Gate

The Noise Gate filter is used to eliminate noise below the selected level.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Noise Gate Settings

To apply the effect, use one of the available presets or configure the effect parameters manually.

The following Noise Gate settings are available for editing:

Threshold - the level (in dB) at which the gate opens. The noise gate filter will affect only the sound below the specified

threshold.

Attack Time - the amount of time it takes the noise gate to change from closed to open once the signal exceeds the specified

threshold.

Release Time - the period during which the noise gate remains open once the signal has fallen below the specified threshold.

Note: the attack and release times are used to smooth the noise gate boundaries. The slower the attack

and release are, the smoother the transition between affected and non-affected signal will be.
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Noise Removal

The Noise Removal effect is used to reduce noise and make the sound clearer. You'll need to specify an audio sample that

will be treated as noise and then detect noise areas in the audio track in accordance with the specified noise profile.

How to Apply

All effects and filters are applied in the same way in AVS Audio Editor. For detailed step-by-step instructions on how to apply effects

to your audio files, refer to the Applying Effects and Filters page.

Noise Removal Settings

Step 1. Configure Noise Settings

You'll need to tell the program what exactly it should treat as noise. You may do it in the Noise Settings section of the settings

window. Click on Get Noise Profile and select the part of an audio track that contains all noise and no audio signal (usually a short

audio portion at the beginning or at the end of an audio track is selected). The start and end times of the selected fragment will be

shown in the opened Get Noise Profile window. When ready, click OK to load the selected fragment as noise profile. Alternatively,

load a previously saved audio profile into the program.

After the profile has been successfully loaded, you will be notified with the appropriate message:

Step 2. Configure Removal Settings

Once the profile is loaded, you may proceed with eliminating noise from your audio track. Use the Removal Settings section of the

settings window to configure noise removal parameters.

Move the Bandwidth sliders to set the band of frequencies that will be affected by the filter. The program will operate only within the

band you set.

Enable the Remove noise option to remove the detected noise areas from your audio track. Enable the Keep only noise option to

keep only noise areas and remove all the rest of audio signal.

Use the Smoothing parameter to smooth the frequency characteristic of the created noise profile. It defines the width of the

smoothing corridor in percent of octave (% oct). For example, for a signal of 1000 Hz the corridor will be 500 (-1 octave) to 2000 (+ 1

octave) if you set the smoothing parameter to 100%. In other words, the bigger the percentage value, the wider the corridor.

Use the Noise Reduction parameter to set the degree of noise suppression in the detected noise areas in dB. Setting a bigger value

will result in greater supression. Setting the parameter to 0 will produce no effect at all.
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Using DirectX Filters

AVS Audio Editor supports DirectX audio plug-ins and filters installed on your computer. DirectX is a development platform designed

by Microsoft which provides an open standard for multimedia plug-ins. DSP modules, and other audio tools based on this standard, can

be used by any application that supports the DirectX architecture.

With the help of DirectX plug-ins you can easily extend the range of powerful effects available in AVS Audio Editor.

DirectX plug-ins are very easy to use. To enable any of them just highlight an area to process and choose a filter from DX Filters

drop-down menu on the DX/VST Tab.

Most DirectX plug-ins have their own settings dialog where you can configure the parameters of the effect. Some plug-ins may support

real-time preview. But, of course, if you have some problems you will need to consult the documentation provided by the plug-in

manufacturer.

Using VST Effects

AVS Audio Editor supports VST audio plug-ins and effects on your computer. VST (Virtual Studio Technology) effects and filters are

native realtime plugins. Initially their standard was developed by Propellerhead/Steinberg. They usually provide a custom graphical user

interface, displaying controls similar to the physical switches and knobs on audio hardware.

With the help of VST effects you can easily extend the range of powerful effects available in AVS Audio Editor.

In case you have VST effects on your computer you will need to point out their directory to AVS Audio Editor program. To do that

press the VST Effects Directories button on the DX/VST Tab. The following dialog window will appear:

Use the Add button to select a directory with VST effects present and click OK to update the effects list. All the effects from the folder

will be loaded automatically and will be available afterwards from the VST Effects drop-down menu on the DX/VST Tab.

You can also add the additional effects and remove the unnecessary ones in this window using the appropriate buttons.

VST effects are very easy to use. To enable any of them just highlight an area to process and choose a filter from the VST Effects

drop-down menu on the DX/VST Tab.

Most VST effects have their own settings dialog where you can configure the parameters of the effect. Some plug-ins may support

real-time preview. But, of course, if you have some problems you will need to consult the documentation provided by the plug-in

manufacturer.
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Batch Processing

When you want to apply one and the same effect to several files, or several effects to one and the same file, or several identical effects

to several files, it can be done quite easily with the help of the Batch Processing option of AVS Audio Editor.

Click the Batch command button on the Effects Tab. The following window will be opened:

Here you can select the effects you would like to apply to the audio file (or files, if there are several of them loaded into AVS Audio

Editor), the order in which they will be applied and their properties.

First of all you can select an effect preset from the list of available ones using the Batch Presets drop-down list. You can also delete

the presets you no longer need using the Delete Preset from List  button. In case you change some of the preset settings

(effects in the list, effect parameters, or something else) or create an absolutely new preset, you can save it using the Save Preset

.

To change the presets order select one of the effects with the mouse and use the Move Up  and Move Down  buttons.

The new effects are added to the effects list using the Effects >> button. The list of all the available effects will be opened to let you

select the necessary one:
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After the effect is added its settings can be easily changed using the Properties button. Please, read the effects description section

to find out more on each effect settings. To remove an effect from the list use the Delete button (do not forget to select the effect to

be deleted with the mouse). The Preview button is used to make sure that the result of the effects application is the one you really

need. The list of files to be used for the effects application can be viewed and changed at the Processed Files tab:

Check the files with the mouse or uncheck the ones that should be excluded from the batch effects application. You can also load

additional files to the list using the Open File button. When ready press the OK button to accept changes and close the window, or

Cancel to discard all the changes and continue work with AVS Audio Editor.

Note: To save multiple files please use the Save All  command button on the Home or File tabs.
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Generating Sounds

Sometimes you might need to create a sound containing some signals that exist in real world but you do not always have a possibility

to record these sounds. AVS Audio Editor lets you create some of these signals using the internal methods.

You can add the following signals to your audio:

Silence

Noise

Signal

Chirp

DTMF Signals

Moreover, the current version of AVS Audio Editor allows you to convert any written text to speech.

Generating Silence

To generate the absence of sound you need to open an audio file or create a new one, select the part of the file where you

want to have a period of silence and click the Silence button of the Generate Tab. The following window will be opened:

You can set the silence duration in milliseconds. Click OK to apply the settings and close the effect window, or the Cancel button to

discard the changes.

Generating Noise

To generate the sound of noise you need to open an audio file or create a new one, select the part of the file where you want

to have a period of noise and click the Noise button on the Generate Tab. The following window will be opened:

You can select the "Color" of the Noise signal (the available values include White, Pink and Brown types of noise different in

sounding), set the noise loudness in decibels and duration in milliseconds.

Click Preview to make sure that the result is alright, OK to apply the settings and close the effect window, or the Cancel button to

discard the changes.
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Generating Signal

To generate the sound of some frequency you need to open an audio file or create a new one, select the part of the file

where you want to have your signal and click the Signal button on the Generate Tab. The following window will be opened:

You can set the following signal properties:

Select the type of the base signal used to create the sound:

select between the Sine, Square and Sawtooth type of the signal;

set the base signal Level in decibels;

select its main Frequency (in Herz);

set the signal Duration in milliseconds.

Set the signal Fading properties:

Fade Level, the level of the signal change - increase or decrease - in time flow (in decibels);

Fading Time, the time in which the Fade Level is reached (in milliseconds).

Select the Modulation parameters:

Modulation Rate used to change the signal applying a signal of different frequency over it (specified in Herz);

Modulation Depth - the intensity of the frequency modulation (in percent).

Note: if you change the signal settings, you can save them as a preset to be able to use them afterwards. Use the

Add button to do that.

Click Preview to make sure that the result is alright, OK to apply the settings and close the effect window, or the Cancel button to

discard the changes.
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Generating Chirp

To generate the chirp sound - a sound with the frequency increase or decrease - you need to open an audio file or create a

new one, select the part of the file where you want to add the chirp signal and click the Chirp button on the Generate Tab.

The following window will be opened:

You can set the following signal properties:

Select the type of the base chirp signal used to create the sound:

set the base signal Level in decibels;

select its Start Frequency (in Herz);

select its End Frequency (in Herz);

set the signal Duration in milliseconds;

set the chirp effect duration (Chirp Time) in milliseconds.

Set the signal Fading properties:

Fade Level, the level of the signal change - increase or decrease - in time flow (in decibels);

Fading Time, the time in which the Fade Level is reached (in milliseconds).

Select the Modulation parameters:

Modulation Rate used to change the signal applying a signal of different frequency over it (specified in Herz);

Modulation Depth - the intensity of the frequency modulation (in percent).

Note: if you change the signal settings, you can save them as a preset to be able to use them afterwards. Use the

Add button to do that.

Click Preview to make sure that the result is alright, OK to apply the settings and close the effect window, or the Cancel button to

discard the changes.
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Generating DTMF Signals

Dual-tone multi-frequency (DTMF) signal is used for telephone signaling over the line in the voice-frequency band to the

call switching center. To generate such signal you need to open an audio file or create a new one, select the part of the file

where you want to have DTMF signaling and click the DTMF Signals button on the Generate Tab. The following window

will be opened:

You can set the following signal properties:

Select the type of the base DTMF signals used to create the sound:

enter the Dial String of the signal - the sequence of digits, letters and special symbols used for DTMF signals designation (the

possible characters that can be used and determine each its own DTMF signal are ten digits - 1, 2, 3, 4, 5, 6, 7, 8, 9 and 0,

four letters - a, b, c and d and two special symbols - * and #);

select the Pause Character used to mark pauses between the DTMF signals;

select the signal Tone Time (in milliseconds) - the duration of a single signal;

select the Break Time (in milliseconds) - the duration of a period of silence between single signals;

select the Pause Time (in milliseconds) - the duration of a period of silence added to mark a pause between single signals;

set the signal Amplitude in percent.

You can also select to use the classic DTMF signals matrix or determine one of your own. The DTMF keypad has a 4x4 matrix, with each

row representing a low frequency, and each column representing a high frequency. Pressing a single key (such as '1' ) will send a

sinusoidal tone of the two frequencies (697 and 1209 Hertz). The original keypads had levers inside, so each button activated two

contacts. The multiple tones are the reason for calling the system multifrequency. In case you customize the DTMF signals matrix and

want to return to initial values, press the Reset to DTMF button.

Note: if you change the signal settings, you can save them as a preset to be able to use them afterwards. Use the

Add button to do that.

Click Preview to make sure that the result is alright, OK to apply the settings and close the effect window, or the Cancel button to

discard the changes.
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Converting Text to Speech

To convert any written text to speech you need to open an audio file or create a new one, select the part of the file where you

want insert the converted text and click the Text to Speech button on the Generate Tab. The following window will be

opened:

Note: To convert text to speech AVS Audio Editor uses Windows TTS engine which is installed with the operating

system, so it can only use the voices installed on your computer. To check the list of all the available voices go to

Control Panel >> Text to Speech and drop-down the Voice selection list. For more information refer to the

Microsoft Support page.

Type in the text you wish to convert in the Text field and adjust the available properties.

Pitch - use this scroller to adjust the voice tone. The lower the value, the lower the tone will be.

Rate - use this scroller to increase or decrease the speech speed.

Volume - use this scroller to adjust the sound volume (move to the left to desrease volume, move to the right to increase

volume).

Click the Preview button to make sure that the result is alright, press OK to apply the settings and close this window, or the Cancel

button to discard the changes.
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Starting Mix Project

AVS Audio Editor lets you mix several audio tracks in one and apply audio effects to your mixes.

To start audio track mixing switch to the Mix Tab of the Ribbon Command Bar.

The work in the Mix Tab is done using the projects. Projects are very useful in case you do not have a possibility to create, edit and

save your mix all at once. Using projects allows you to save the work done (even if it's not completed yet) to a file of special format

and proceed with mixing next time by opening the previously saved project file.

Creating a New Project

Normally when you switch to this tab a new empty project is automatically created for you. But you can create a new project any time

during mixing clicking the New Project  button on the Mix Tab. You will be presented with the confirmation window asking you

whether to save or not what's currently loaded in the mix area:

Pressing Yes will open the Save Project window and you'll be able to save the current mix as a project. Pressing No will just clear up

all lines in the mix area without saving what's loaded there.

Once the project is created, add audio tracks that you plan to use in your mix in one of the following ways:

To add a previously loaded file, switch to the Files tab on the Files and Effects panel and double-click the needed file.

To add a new file, click the Open Audio File button on the Mix Tab, select the necessary file in the opened Windows Explorer

window and click the Open button.

Alternatively, right-click within the Audio Mix line of the Mix Timeline, choose the Open and Add File to Mix option, select

the necessary file in the opened Windows Explorer window and click the Open button.

All the selected tracks will be added to the Mix Timeline and placed one under another.
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Opening an Existing Project

To open a previously saved mix project for further editing, click the Open Project...  button on the Mix Tab.

In the opened window browse for the needed project and click OK. The selected project will be loaded to AVS Audio Editor.

Alternatively, click the arrow next to the Open Project... button and select the needed project from the Recent Projects list.

The selected project will be loaded into the program and displayed in the mix working space.
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Editing Mix Project

All the audio tracks you add will be displayed within the Mix Timeline which helps to manage your files and edit them.

Changing Audio File Position

All the audio tracks added for mixing are placed one under another by default. This means they will be played back simultaneously. You

may change the position of any audio track by dragging. Files may be dragged along their original line or placed to any other line below

or above.

Click with the left mouse button within the audio track block and move it up or down to change the file order, or move it to the

left/right to change the file position within its original line.

Trimming Audio File

To cut out the beginning or end of an audio track, drag its boundaries inwards.
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Splitting Audio File and Deleting Parts

To split an audio track in parts, place the cursor where you want the file to be split and click the Split Object command button on the

Mix Tab or use the corresponding option of the right-click menu.

After that you can delete some unwanted parts selecting them with the mouse and clicking the Delete Object command button on the

Mix Tab or using the corresponding option of the right-click menu.

Adjusting Audio File Volume and Balance

To adjust the audio file volume and balance use the corresponding sliding bars on the left of the selected line. You can also mute the

selected audio file or mute all the audio files except the selected one by clicking the Mute or Solo buttons respectevely.

To adjust the volume and balance of whole audio mix use the sliding bars of the Mix Volume button group on the Mix Tab.

Inserting Audio Recording

To insert some voice recording place the mouse cursor within the Audio Recording line of the Mix Timeline where you want your

recording to start and click the Record button on the left.
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Applying Effects

To apply an effect to your audio mix, click the needed effect button on the Mix Tab. The effect will be added to the Audio Effect line

of the Mix Timeline. The applied effect covers only a part of your mix by default. You may change the effect application area by

dragging its boundaries.

To change the applied effect properties, double-click it on the Mix Timeline. This will open the effect properties window. To learn more

about configuring the parameters of some specific effect, please refer to the corresponding effect page in the Using Effects and

Filters section.

To delete an effect, use the Delete Object command button on the Mix Tab or right-click the effect and select the corresponding

option of the right-click menu.

Note: the effect will be applyed to ALL audio tracks used in your audio mix.

When the mix is ready use the Playback button on the Bottom Toolbar to check the results of your work.
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Saving Mix Project

AVS Audio Editor allows you to export your created audio mix to an audio file or just save it to a .mix project file.

Saving to a Project File

Saving an audio mix to a project file gives you the possibility to go back to it later and make some further changes. To do that click the

Save Project button of the Mix Project button group. The following window will be opened:

Type in the name for your project in the File Name field, select the project location from the Folder drop-down list and click the Save

button.

A project file with the .mix extension will be saved to the specified location.
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Saving to an Audio File

Saving the created audio mix to an audio file will produce an audio track of the selected format.

To do that click the Export Audio command button on the Mix Tab. The Export Mix to Audio File window will be opened:

Select the output audio file format and specify the output audio parameters such as Sample Rate (Frequency), Bitrate and the

number of Channels.

Set a location for you audio track and click the OK button to start saving.
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Changing AVS Audio Editor Settings

You can customize AVS Audio Editor colors, devices and other settings so that it were convenient for you to work with the program.

To open the Options window click the Options  button on the Tools Tab.

The Options window contains the following tabs:

General settings

View settings

Colors settings

Recording settings

Playback settings

The General settings tab lets you edit the following parameters:

Temporary directory - the temporary folder used to store the currently edited files. It should be large enough to store

uncompressed versions of the edited files as AVS Audio Editor works with files in its own audio format.

Undo - Undo/Redo count - the maximal number of undo/redo operations that can be performed.

Effects - enable the Smoothly edit boundaries by crossfading option to determine the threshold of the effect. Normally

when this option is enabled the effect will start gradually, there is no sharp transition from the audio without effect to the audio

where the effect is applied. You can also set the Crossfading time (in milliseconds) during which this transition will be applied.
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The View settings tab lets you edit the following parameters:

Spectral Display - change the view of the audio timeline when the Spectral View is selected. You can change the

Resolution, selecting the number of bands used to display a sample (16 to 4096 bands), choose the Spectral View color

scheme from the presets list or manually alter them using the Spectral Low and Spectral High fields (0 to 360 values of

colors selected from the color circle).

Effects list - use this option to enable or disable the display of effect tooltips in the Files and Effects Panel.

Waveform Display - change the view of the audio timeline when the Waveform View or Envelope View is selected. You

can enable/disable the grid lines, central line and the waveform boundary lines display.

Markers - use this option to enable or disable the display of the marker names. When enabled this option will allow the

markers to be shown with the names assigned to them automatically or by user in the Markers List.

The Colors settings tab lets you edit the following parameters:

The Color Scheme pull-down menu contains all the available color schemes for Waveform View and Envelope View. In case you

would like to choose one, simply select it from the list. The currently selected color scheme will be displayed in the example window in

the right part of the page.

The Display elements represent a list of all the elements within the waveform display with their current color. This list will change to

AVS4YOU Programs Help - AVS Audio Editor

© Online Media Technologies Ltd., UK 2004 - 2011   All rights reserved. www.avs4you.com

Page 126 of  128

http://www.avs4you.com/index.aspx
http://www.avs4you.com/index.aspx


reflect the changes made to any of the display elements. To change the color of any of the display elements you can double-click the

necessary element or click the element and press the Change Color button. This will bring the color selection dialog:

Use this dialog to choose a color for the currently highlighted item in the Display Elements list.

To save the current color scheme as a preset press the Save As... button.

To delete the currently selected preset press the Delete button.

The Recording settings tab lets you edit the following parameters:

You can select the input device used for sound recording, the input jack of the selected device, set the balance, gain and some

advanced device parameters, if any. You can also test the device to make sure it works. See the Playing and Recording section of

help file for more detail on this.
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The Playback settings tab lets you edit the following parameters:

You can select the input device used for playback, as well as set its volume and balance. See the Playing and Recording section of

help file for more detail on this.

AVS4YOU Programs Help - AVS Audio Editor

© Online Media Technologies Ltd., UK 2004 - 2011   All rights reserved. www.avs4you.com

Page 128 of  128

http://www.avs4you.com/index.aspx
http://www.avs4you.com/index.aspx

	 AVS Audio Editor
	Introduction
	Contact Us
	Technical Support
	Resources
	Overview

	Program Interface
	Application Button
	Quick Access Toolbar
	Ribbon Command Bar
	Home Tab
	File Tab
	Edit Tab
	Record Tab
	Effects Tab
	Generate Tab
	DX/VST Tab
	Tools Tab
	Mix Tab
	Favorites Tab
	Help Tab

	Files and Effects Panel
	Waveform Editing Space
	Mix Timeline
	Bottom Toolbar
	Status Bar
	Frequency Analysis Window
	Phase Analysis Window
	Keyboard and Mouse Shortcuts

	Working with AVS Audio Editor
	Supported Formats
	Supported Audio Formats
	Supported Video Formats

	Operations with Files
	Creating a New File
	Opening Files
	Opening Audio Files
	Opening Video Files

	Grabbing Audio CDs
	Importing Audio Tracks from Video
	Viewing File Info/Editing Audio Tags
	Saving Files
	Saving Audio Files
	Saving Video Files


	Playing and Recording
	Editing Options
	Copying
	Pasting
	Deleting and Trimming
	Convert Sample Type
	Using Markers
	Setting Markers
	Managing Marker List
	Splitting by Markers


	Editing Individual Channels
	Applying Effects and Filters
	Amplitude Effects
	Amplify
	Fade In/Fade Out
	Normalize
	Envelope
	Compressor
	Multiband Compressor
	Mute
	Invert
	Limiter
	Auto Correction

	Delay/Modulation Effects
	Echo
	Chorus
	Flanger
	Phaser
	Reverb
	Vibrato
	Voice Morpher

	Time Stretch/Pitch Shift Effects
	Tempo Change
	Pitch Shift
	Rate Change
	Reverse

	Filters
	Equalizer
	Parametric Filters
	High-Pass Filter
	Low-Pass Filter
	Band-Pass Filter
	Band-Stop Filter
	Notch Filter
	Resonance

	FFT Filter
	Delete Silence
	Noise Gate
	Noise Removal

	Using DirectX Filters
	Using VST Effects
	Batch Processing

	Generating Sounds
	Generating Silence
	Generating Noise
	Generating Signal
	Generating Chirp
	Generating DTMF Signals
	Converting Text to Speech

	Mixing Audio Tracks
	Starting Mix Project
	Editing Mix Project
	Saving Mix Project

	Changing AVS Audio Editor Settings



